
http://www.facebook.com/share.php?u=http://www.informIT.com/title/9780137904105
http://twitter.com/?status=RT: download a free sample chapter http://www.informit.com/title/9780137904105
http://www.linkedin.com/shareArticle?mini=true&url=http://www.informit.com/title/9780137904105


Apple Pro Training Series

Logic Pro
Professional Music Production

David Nahmani



Logic Pro – Apple Pro Training Series: Professional Music Production
David Nahmani
Copyright © 2022 by David Nahmani. All Rights Reserved.

Peachpit Press
www.peachpit.com
Peachpit Press is an imprint of Pearson Education, Inc.
To report errors, please send a note to errata@peachpit.com.

Apple Series Editor: Laura Norman
Editor: Robyn G. Thomas
Senior Production Editor: Tracey Croom 
Production Coordinator: Maureen Forys, Happenstance Type-O-Rama
Technical Editor: John Moores
Proofreader: Scout Festa
Compositor: Cody Gates, Happenstance Type-O-Rama
Indexer: Rachel Kuhn
Cover Illustration: Von Glitschka
Cover Production: Cody Gates, Happenstance Type-O-Rama

Fast Jam © 2020, composed and produced by David Nahmani. All rights reserved.
Sampler Feast © 2020, composed and produced by David Nahmani. All rights reserved.
Future Nostalgia © 2020, composed and produced by David Nahmani. All rights reserved.
Drum Samples, performed and recorded by Jon Mattox. All rights reserved. For more on Jon Mattox, visit https://jonmattox.com.
Moments (Pop Mix) (by Darude featuring Sebastian Rejman) © 2016, music and lyrics by V. Virtanen, S. Rejman, and J. Ehnqvist. 
All rights reserved. For more on Darude, visit www.darude.com, www.facebook.com/Darude, www.instagram.com/Darude,  
www.twitter.com/Darudevil, www.youtube.com/Darude, and www.twitch.tv/Darude.
Lights On © 2018, composed and produced by Distant Cousins. All rights reserved. For more on Distant Cousins,  
visit www.distantcousinsofficial.com, www.facebook.com/DistantCousinsOfficial and www.instagram.com/distantcousinsofficial.
Drum samples in this book were used with permission of the three artists who contributed: Jon Mattox, Distant Cousins, and Darude.
The projects and footage supplied with this book may only be used for educational purposes in association with the lessons included. 
Any other use, including but not limited to incorporating footage into another project, duplicating or distributing footage, is expressly 
forbidden and requires explicit permission from the copyright holders listed above.

Notice of Rights
This publication is protected by copyright, and permission should be obtained from the publisher prior to any prohibited reproduc-
tion, storage in a retrieval system, or transmission in any form or by any means, electronic, mechanical, photocopying, recording, 
or otherwise. For information regarding permissions, request forms and the appropriate contacts within the Pearson Education 
Global Rights & Permissions department, please visit www.pearson.com/permissions.

Notice of Liability 
The information in this book is distributed on an “As Is” basis, without warranty. While every precaution has been taken in the 
preparation of the book, neither the author nor Peachpit shall have any liability to any person or entity with respect to any loss or 
damage caused or alleged to be caused directly or indirectly by the instructions contained in this book or by the computer software 
and hardware products described in it.

Trademarks 
Unless otherwise indicated herein, any third party trademarks that may appear in this work are the property of their respective own-
ers and any references to third party trademarks, logos or other trade dress are for demonstrative or descriptive purposes only. Such 
references are not intended to imply any sponsorship, endorsement, authorization, or promotion of Pearson Education, Inc. products 
by the owners of such marks, or any relationship between the owner and Pearson Education, Inc., or its affiliates, authors, licensees 
or distributors.

ISBN 13: 978-0-13-790410-5
ISBN 10: 0-13-790410-X 

ScoutAutomatedPrintCode

http://www.peachpit.com
mailto:errata@peachpit.com
https://jonmattox.com
http://www.darude.com
http://www.facebook.com/Darude
http://www.instagram.com/Darude
http://www.twitter.com/Darudevil
http://www.youtube.com/Darude
http://www.twitch.tv/Darude
http://www.distantcousinsofficial.com
http://www.facebook.com/DistantCousinsOfficial
http://www.instagram.com/distantcousinsofficial
http://www.pearson.com/permissions


Acknowledgments I would like to express my thanks to my wife Nathalie 
and to my sons, Liam and Dylan, for their support and encouragement; to Bill 
Burgess, for believing in me and encouraging me when I first started; and to my 
editors, Robyn Thomas, John Moores, and Laura Norman, for being by my side 
and enabling me to write the best book I could write. 

My deepest gratitude to the artists and producers who agreed to provide their 
media, songs, and Logic projects for this book: Distant Cousins, for their song 
“Lights On”; Darude, for his song “Moments”; and Jon Mattox, for providing 
drum samples. 





Contents at a Glance

v

Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . x

Lesson 1 Producing Music with Logic Now!  . . . . . . . . . . . . . . . . . . . . . . . . 3

Lesson 2 Producing a Virtual Drum Track  . . . . . . . . . . . . . . . . . . . . . . . .  81

Lesson 3 Using Effect and Instrument Plug-ins . . . . . . . . . . . . . . . . . . . . 129

Lesson 4 Recording Audio and MIDI . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Lesson 5 Sampling Audio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235

Lesson 6 Performing with MIDI Controllers and Logic Remote . . . . . 293

Lesson 7 Creating Content  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  331

Lesson 8 Integrating Your Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 377

Lesson 9 Editing Pitch and Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389

Lesson 10 Mixing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 427

Lesson 11 Mixing in Dolby Atmos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 485

Appendix A Skills Review . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  517

Appendix B Keyboard Shortcuts (Default for U.S. Keyboard) . . . . . . . . . . 523

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  531



Table of Contents

vi

Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . x

Lesson 1 Producing Music with Logic Now! . . . . . . . . . . . . . . 3
Creating a Logic Pro Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Perform in Real Time with Live Loops . . . . . . . . . . . . . . . . . . . . . 9
Exploring the Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Navigating and Building the Project  . . . . . . . . . . . . . . . . . . . . . . 34
Editing Regions in the Workspace . . . . . . . . . . . . . . . . . . . . . . . . 54
Mixing the Song  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Mixing Down to a Stereo File . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Lesson 2 Producing a Virtual Drum Track . . . . . . . . . . . . . . 81
 Creating a Drummer Track . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
 Arranging the Drum Track . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
 Customizing the Drum Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
 Working with an Electronic Drummer . . . . . . . . . . . . . . . . . . . 113

Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Lesson 3 Using Effect and Instrument Plug-ins  . . . . . . . . . 129
Inserting Plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
Loading and Editing Patches . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
Setting Up Parallel Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Moving and Copying Plug-ins  . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Saving User Patches and Plug-in Settings . . . . . . . . . . . . . . . . . 166
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169



Contents  vii

Lesson 4 Recording Audio and MIDI . . . . . . . . . . . . . . . . . . 171
Setting Up Digital Audio Recording  . . . . . . . . . . . . . . . . . . . . . 171
Recording Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Recording Additional Takes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
Punching In and Out . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
Deleting Unused Audio Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . 204
Recording MIDI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208
Correcting the Timing of a MIDI Recording . . . . . . . . . . . . . . 214
Recording Over a MIDI Region . . . . . . . . . . . . . . . . . . . . . . . . . 217
Recording Into Live Loop Cells  . . . . . . . . . . . . . . . . . . . . . . . . . 220
Recording Without a Metronome  . . . . . . . . . . . . . . . . . . . . . . . 229
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233

Lesson 5 Sampling Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
Sampling Single Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
Sampling and Slicing Drums . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
Transposing a Sample While Keeping  
It Synced to the Project Tempo . . . . . . . . . . . . . . . . . . . . . . . . . . 267
Chopping Loops in a Take Folder  . . . . . . . . . . . . . . . . . . . . . . . 270
Creating Vocal Chops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291

Lesson 6 Performing with MIDI  
Controllers and Logic Remote . . . . . . . . . . . . . . . . 293
Assigning Hardware Controllers  . . . . . . . . . . . . . . . . . . . . . . . . 293
Mapping Smart Controls to Plug-ins . . . . . . . . . . . . . . . . . . . . . 302
Controlling Logic from an iPad Using Logic Remote . . . . . . . 309
Performing Live DJ Effects with Remix FX  . . . . . . . . . . . . . . . 324
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329

Lesson 7 Creating Content . . . . . . . . . . . . . . . . . . . . . . . . . . . 331
Step Sequencing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332
Programming MIDI in the Piano Roll . . . . . . . . . . . . . . . . . . . . 348
Editing Audio Regions and Adding Fades  . . . . . . . . . . . . . . . . 362
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 374



viii   Contents

Lesson 8 Integrating Your Workflow . . . . . . . . . . . . . . . . . . 377
Importing Audio into Drum Machine Designer . . . . . . . . . . . 377
Populating Scenes in the Live Loops Grid  . . . . . . . . . . . . . . . . 381
Copying or Recording Scenes in the Tracks View . . . . . . . . . . 384
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387

Lesson 9 Editing Pitch and Time . . . . . . . . . . . . . . . . . . . . . . 389
Setting a Project Tempo by Detecting 
 the Tempo of a Recording. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389
Matching an Audio File to the Project Key and Tempo . . . . . 395
Creating Tempo Changes and Tempo Curves  . . . . . . . . . . . . . 398
Making One Track Follow the Groove of Another Track . . . . 403
Changing the Playback Pitch and Speed with Varispeed . . . . 406
Editing the Timing of an Audio Region  . . . . . . . . . . . . . . . . . . 409
Tuning Vocal Recordings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 418
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 425

Lesson 10 Mixing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 427
Organizing Windows and Tracks . . . . . . . . . . . . . . . . . . . . . . . . 428
Adjusting Volume, Pan, EQ, and Reverb . . . . . . . . . . . . . . . . . . 437
Processing Lead Vocals  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 450
Automating Mixer Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . 464
Quick Mastering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 473
Exporting the Mix to a Stereo Audio File . . . . . . . . . . . . . . . . . 478
Using a Few Tips and Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . 481
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 483

Lesson 11 Mixing in Dolby Atmos . . . . . . . . . . . . . . . . . . . . . 485
Preparing for Dolby Atmos Mixing . . . . . . . . . . . . . . . . . . . . . . 485
Panning Tracks in the Surround Field . . . . . . . . . . . . . . . . . . . . 495
Using Surround Audio Effect Plug-Ins . . . . . . . . . . . . . . . . . . . 503
Exporting a Dolby Atmos Master File . . . . . . . . . . . . . . . . . . . . 512
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 515



Contents  ix

Appendix A Skills Review . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 517

Appendix B Keyboard Shortcuts  
(Default for U.S. Keyboard) . . . . . . . . . . . . . . . . . . 523

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 531



x

Welcome to the official Apple Pro Training Series course for Logic Pro. 

This book is a comprehensive introduction to professional music pro-

duction with Logic Pro. It uses real-world music and hands-on exercises 

to teach you how to record, edit, arrange, mix, produce, and polish 

audio and MIDI files in a professional workflow. So let’s get started!

The Methodology

This book takes a hands-on approach to learning the software, so you’ll be 
working through the project files and media you download after registering 
the book at www.peachpit.com/apts.logicpro. It’s divided into lessons that 
introduce the interface elements and ways of working with them, building 
progressively until you can comfortably grasp the entire application and its 
standard workflows.

Each lesson in this book is designed to support the concepts learned in the 
preceding lesson, and first-time readers should go through the book from start 
to finish. However, each lesson is self-contained, so when you need to review a 
topic, you can quickly jump to any lesson.

The book has 11 chapters that are designed to guide you through the music 
production process as it teaches Logic. 

Lesson 1 starts you with an overview of the entire process. You’ll become 
familiar with the interface and the various ways to navigate a project; use 
Apple Loops to build songs from scratch in the Live Loops grid and in the 
linear Tracks view editor. You’ll then arrange, mix, and export a song to an 
MP3 file.

Getting Started

http://www.peachpit.com/apts.logicpro
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Lesson 2 focuses on drum tracks, the foundation of your song. You’ll use Drummer to gen-
erate virtual drumbeat performances triggering acoustic and electronic drum instruments. 

In Lesson 3, you will explore effect and instrument plug-ins, use the Library to load 
patches and presets, and save your own plug-in settings. 

Lesson 4 dives deeper into typical situations that you may encounter when recording 
audio sources (such as microphones and guitars) and MIDI controllers. You’ll record both 
in the Tracks view editor and in the Live Loops grid. 

You will use the new Quick Sampler instrument plug-in in Lesson 5 to turn a voice into a 
synthesizer pad, record your own handclap sample, create vocal chop effects, and sample a 
bass sound from a loop to create your own bass line.

Lesson 6 shows you how to map MIDI controllers to Logic to trigger loops, navigate the 
project, and adjust plug-in parameters. You will explore the free Logic Remote app (for 
iPad and iPhone) to control Logic from your multi-touch screen and use the iPad’s built-
in gyroscope to modulate effects. 

To create content in Lesson 7, you’ll program MIDI notes in the Piano Roll, create drum-
beats and step automation in Logic’s new Step Sequencer, edit Audio regions, and add 
fades and turntable start and stop effects.

Lesson 8 is an overview of a workflow that integrates multiple features—learned in the 
previous lessons—into a complete music production process. You’ll start by building your 
own drum instrument with samples, program a drumbeat in Step Sequencer, combine it 
with recordings and Apple Loops in the Live Loops grid, and record your Live Loops per-
formance into the Tracks view to build an arrangement.

Lesson 9 explores various ways to edit the pitch and time of your recordings, using Smart 
Tempo to ensure that all your audio files play at the same tempo; creating custom tempo 
curves; using groove tracks and Varispeed; time-stretching audio; and tuning vocals. 

You’ll study the end processes of music production in Lesson 10: mixing, automating, and 
mastering using track stacks, EQ, compressor, limiter, and delay and reverb plug-ins. You 
will export your final mix as a stereo audio file.

In Lesson 11, you’ll take a stereo project and set it up for mixing in Dolby Atmos. You will 
explore the Dolby Atmos plug-in, and position sounds in the 3D surround field. You will 
process tracks with surround audio effects plug-ins and use mastering plug-ins to follow 
the Dolby Atmos specifications.

Appendix A lists a wealth of useful keyboard shortcuts to help speed up your workflow.
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System Requirements

Before using Logic Pro – Apple Pro Training Series, you should have a working knowledge 
of your Mac and the macOS operating system. Make sure that you know how to use the 
mouse or trackpad and standard menus and commands, and how to open, save, and close 
files. If you need to review these techniques, see the printed or online documentation 
included with your system.

Logic Pro and the lessons in this book require the following system resources:

 ▶ macOS 11 “Big Sur” or later

 ▶ Minimum of 72 GB of disk space for full Sound Library installation

 ▶ High-speed internet connection for installation

 ▶ MIDI keyboard controller (optional but recommended to play and record software 
instruments) connected via USB or via a compatible MIDI interface 

 ▶ (optional) iPhone or iPad with iOS 14.0 or later for controlling Logic using the Logic 
Remote iPad app as shown in Lesson 6

Preparing Your Logic Workstation

The exercises in this book require that you install Logic Pro along with the entire Apple 
Sound Library (including the Legacy and Compatibility content). If you have not yet 
installed Logic, you may purchase it from the App Store. When your purchase is com-
pleted, Logic Pro will automatically be installed on your hard drive, and you will be 
prompted to install the Apple Sound Library, as detailed at the beginning of Lesson 1.

Some of the instructions and descriptions in this book may vary slightly, depending on 
the sounds you have installed.

When you first open Logic Pro, the app will automatically download and install the essen-
tial content. If you get an alert offering to download more sounds, continue to download 
and install all the sounds. 

To make sure the complete Apple Sound Library is installed on your Mac, choose Logic 
Pro > Sound Library > Open Sound Library Manager, and click Select All Uninstalled. 
Make sure the Legacy and Compatibility content is selected, and then click Install.

NOTE ▶  If you choose not to download the entire Logic sound library, you may be 
unable to find some of the media needed in the exercises. Missing media will appear 
dimmed with a down arrow icon. Click the down arrow icon to download that media.
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Online Content

Your purchase of Logic Pro – Apple Pro Training Series includes online materials provided 
by way of your Account page at www.peachpit.com. These include the following.

Lesson files

The downloadable content for Logic Pro – Apple Pro Training Series includes the project 
files you will use for each lesson, as well as media files that contain the audio and MIDI 
content you will need for each exercise. After you save the files to your hard disk, each 
lesson will instruct you in their use. To download the lesson files, you will need to step 
through the instructions in the “Accessing the Lesson Files and Web Edition from  
www.peachpit.com” section.

Free Web Edition

The Web Edition is a free online version of the book that is included with your purchase. 
Your Web Edition can be accessed on the www.peachpit.com site from any device with a 
connection to the Internet.

Accessing the Lesson Files and Web Edition from www.peachpit.com

1 Go to www.peachpit.com/apts.logicpro.

2 Sign in or create a new account.

3 Click Register.

4 Answer the question as proof of purchase.

The lesson files can be accessed from the Registered Products tab on your Account page. 

5 Click the Access Bonus Content link below the title of your product to proceed to the 
download page. 

6 Click the lesson file link(s) to download them to your computer. 

The Web Edition can be accessed from the Digital Purchases tab on your Account page. 

7 Click the Launch link to access the product.

http://www.peachpit.com
http://www.peachpit.com$$$�
http://www.peachpit.com
http://www.peachpit.com
http://www.peachpit.com/apts.logicpro
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NOTE ▶ If you’ve enabled the Desktop and your Document folder to sync to iCloud, 
you are strongly advised not to copy your lesson files to your Desktop. Choose 
another location, such as the Logic folder within your Music folder.

8 After downloading the file to your Mac desktop, you’ll need to unzip the file or 
mount the disk image to access a folder named Logic Book Projects, which you will 
save or move to your Mac desktop. Each lesson explains which files to open for that 
lesson’s exercises.

NOTE ▶  If you purchased a digital product directly from www.peachpit.com, your 
product will already be registered. However, you still need to follow the registration 
steps and answer the proof-of-purchase question before the Access Bonus Content 
link will appear under the product on your Registered Products tab.

Using Default Preferences and Key Commands, and Selecting the 
Advanced Tools

All the instructions and descriptions in this book assume that you are using the default 
preferences (unless instructed to change them). At the beginning of Lesson 1, you will be 
instructed how to use Logic in Complete mode.

If you have already chosen to use Logic in Simplified mode, you can choose Logic Pro > 
Preferences > Advanced and select Enable Complete Features to use Logic in Complete 
mode.

If you have changed some of your Logic Pro preferences, you may not see the same results 
as described in the exercises. To make sure that you can follow along with this book, it’s 
best to revert to the initial set of Logic preferences before you start the lessons. Keep in 
mind, however, that when you initialize preferences, you lose your custom settings, and 
later you may want to reset your favorite preferences manually.

1 Choose Logic Pro > Preferences > Reset All Preferences Except Key Commands.

A confirmation message appears.

2 Click Initialize.

Your preferences are initialized to their default states.

http://www.peachpit.com
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NOTE ▶  After initializing Preferences, you may need to re-select the desired audio 
interface: choose Logic Pro > Preferences > Audio, choose your audio interface from 
the Output Device and Input Device pop-up menus, and make sure Core Audio is 
enabled. The first time you create a new audio track, in the New Track dialog, make 
sure Output is set to Output 1 + 2.

Using the U.S. Key Command Preset

This book assumes that you are using the default initialized key command preset for a U.S. 
keyboard. If you have customized your key commands, you may find that some of the key 
commands in your Logic installation do not function as they are described in this book.

If at any point you find that the key commands don’t respond as described in this book, 
make sure the U.S. key command preset is selected on your Mac by choosing Logic Pro > 
Key Commands > Presets > U.S.

Screen Resolution

Depending on your display resolution, some of the project files may appear different on 
your screen than they do in the book. When you open a project, if you can’t see the whole 
main window, move the window until you can see the three window controls at the left of 
the title bar and Option-click the Zoom button (the green button, third from the left) to 
fit the window to the screen.

When using a small display, you may also have to zoom or scroll more often than 
instructed in the book when performing some of the exercise steps. In some cases, you 
may have to temporarily resize or close an area of the main window to complete an action 
in another area.

About the Apple Pro Training Series

Logic Pro – Apple Pro Training Series is a self-paced learning tool and Apple’s official guide 
for Logic Pro. Books in this series also include downloadable lesson files and an online 
version of the book. The lessons are designed to let you learn at your own pace.

For a complete list of Apple Pro Training Series books, visit www.peachpit.com/apple.

http://www.peachpit.com/apple
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Resources

Logic Pro – Apple Pro Training Series is not intended as a comprehensive reference manual, 
nor does it replace the documentation that comes with the application. For comprehensive 
information about program features, refer to the following resources:

 ▶ The Logic Pro User Guide, accessed through the Help > Logic Pro Help menu in 
Logic Pro, contains a description of most features. Other documents available in the 
Help menu can also be valuable resources.

 ▶ The Logic Pro Help website, an online community of Logic users moderated by the 
author of this book, David Nahmani: www.logicprohelp.com/forum.

 ▶ The Apple websites www.apple.com/logic-pro/ and www.apple.com/support/logicpro/.

 ▶ The official Logic Pro release notes: https://support.apple.com/en-us/HT203718/.

 ▶ For additional help with accessing the lesson files, contact us at  
www.peachpit.com/support.

http://www.logicprohelp.com/forum
http://www.apple.com/logic-pro/
http://www.apple.com/support/logicpro/
https://support.apple.com/en-us/HT203718/
http://www.peachpit.com/support


Lesson Files Logic Book Projects > Media > Just Like This Vocal.wav

Logic Book Projects > 05 Sample Feast

Time This lesson takes approximately 60 minutes to complete.

Goals Import audio files into Quick Sampler

Record audio into Quick Sampler

Edit sample start, end, and loop points on the waveform display 

Turn a sustained vocal note into a pad synthesizer sound

Import a drumbeat and slice it into individual drum hits

Modulate sample pitch and volume with LFOs and envelopes

Splice different audio regions into a sound collage

Use a vocal recording to produce vocal chops

5
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Shortly after the first analog tape recorders appeared around 1935, com-

posers started using the recording medium as a compositional tool—

manipulating the audio playback using reverberation and echo; using 

voltage control devices that changed the tape speed and thus altered 

playback speed and pitch; and using punch recording to splice differ-

ent sounds together. Throughout the following decades, electroacoustic 

composers—and later pioneering electronic musicians—fascinated by the 

new unique sounds they could come up with, continued exploring audio 

transformation techniques involving recording devices to stray away from 

the classic acoustic instrument sounds of composers from past centuries. 

In 1988, Roger Linn designed the AKAI MPC60, which quickly became the 
most legendary sampler and had a major impact on hip-hop music. The iconic 
MIDI sampler made it easy to trigger samples by finger drumming on its built-in 
square pads, while recording the performance onto its built-in sequencer. Today, 
you would be hard-pressed to find a music genre where sampling isn’t used.

In this lesson, you’ll explore Quick Sampler, a new Logic Pro software instru-
ment plug-in. You’ll import a handclap, record a sample, and then turn a 
sustained vocal note into a pad synthesizer sound. You’ll slice a drum loop, 
shortening the volume envelope of the individual slices, and add a gritty filter to 
give it a low-fidelity sound. You’ll splice loops together to combine notes from 
different instruments into a composite melody, creating an exhilarating rhyth-
mic sound collage. Finally, you’ll edit samples into an effect called vocal chops.

Sampling Audio
Lesson 5

235
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Always consider the source of your sampling, and if any of that material is copyrighted, 
make sure you thoroughly research sample clearance. Two easy ways to avoid worrying 
about potential legal issues are to sample your own instruments or noises around you, or 
to sample the royalty-free Apple Sound Library content that you downloaded along with 
Logic Pro (such as software instruments or Apple Loops). 

Sampling Single Notes

The easiest way to use samples in your productions is to import or record a single note 
into Quick Sampler, and then trigger that single note from your MIDI keyboard. In Quick 
Sampler, you can modulate the sample’s pitch to give it a vibrato effect, adjust the volume 
envelope, and loop a section of the sample so that you can sustain its sound.

Importing Audio in Quick Sampler and Selecting a Mode

In this exercise, you’ll use an Apple Loop of finger snaps to create a Quick Sampler instru-
ment so that you can trigger the audio file using your MIDI controller keyboard. To get 
started with a rhythmic reference, you’ll first import a loop to create a drum track.

1 Choose File > New (or press Shift-Command-N).

An empty project is created, and the New Track dialog opens.

2 In the New Track dialog, select Audio, and click Create (or press Return). 

3 Open the Loop Browser, find Throwback Funk Beat 01, and drag it to the audio track 
at bar 1. 

4 In the Region inspector, click the Loop checkbox (or press L). 

In the workspace, the audio region is looped throughout the project. Now let’s create a 
new track for Quick Sampler.
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5 At the top of the track headers, click the + button (or press Command-Option-N). 

6 In the New Track dialog, choose Software Instrument, make sure the Instrument pop-
up menu is set to Empty Channel Strip, and click Create (or press Return).

7 Click the Instrument slot, and choose Quick Sampler (Single Sample).

8 In the Loop Browser, search for bounce snap.

9 Drag Lets Bounce Snaps to the waveform display in Quick Sampler.

In the waveform display, two areas appear (Original and Optimized).

10 Drop the file onto Original.
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The audio file is imported into Quick Sampler, and its waveform is displayed. Below 
the waveform display on the left, the root key is C3. 

 You’ll trigger samples using specific note pitches throughout this lesson. If 
you need to see incoming MIDI note pitches in the MIDI input activity monitor, click 
the small arrow to the right in the LCD display and choose Custom.

11 Play a C3 on your keyboard. 

In Classic mode, the sample plays back while you hold down the key on your key-
board and stops playing when you release the key. Play a C3, and hold down the key 
for a while. The audio file starts with silence and contains finger snaps and handclaps. 
To turn it into a playable instrument, in the next exercise you’ll adjust the start and 
end markers so that a C3 note immediately triggers only the last handclap.

12 Play notes other than C3 on your keyboard. 

The sample is transposed chromatically across the keyboard, according to the pitch of 
the note you play. Higher pitches make the sample play back faster, and lower pitches 
make it play back slower, much like classic samplers, and also like the results you’d get 
from manipulating the speed of analog tape or a turntable. You’ll change that behavior 
for other samples later. For this finger snap sample, you’ll play only C3 notes to trig-
ger the sample at its original speed and pitch.

To avoid having to hold down the key for the whole duration of the sample, you’ll use 
the One Shot mode. 
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13 Click One Shot.

14 Play a C3. 

In One Shot mode, the sample plays back from the start marker to the end marker, 
even if you release the key earlier. This mode is adapted for drum sounds, because 
you can trigger drum hits with pads or drum controllers that send very short notes, 
and still play the full duration of the drum sample. 

 To stop a sample from playing back in One Shot mode, turn the Quick 
Sampler plug-in off and on, or press the Space bar twice to start and stop playback. 

You have created your first sampler instrument with a finger snap sample and selected the 
One Shot mode. You are now ready to start editing the portion of the sample you want to 
play back in the waveform display.

Editing Markers in the Waveform Display

When editing a drum sample, it’s crucial to make sure the sample starts playing exactly 
when you trigger it. You’ll now use the waveform display in Quick Sampler to precisely 
adjust the start and end marker locations, making sure only the fourth finger snap on the 
waveform is triggered. Don’t worry about finding the perfect position right away. You’ll 
later zoom in to readjust the start marker position with more precision.

1 In the waveform display, drag the start marker to beginning of the last handclap.
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Below the waveform display, parameters and values related to the current action are 
displayed.

2 Play a C3.

This time only the last handclap plays. 

3 Drag the end marker a little closer to the end of the waveform.

You’ll now zoom in on the waveform between the start and end marker.

4 At the upper right of the waveform display, click the Zoom horizontal button.

The zoom level is optimized to show the area between the sample start and end mark-
ers. To help position the start marker exactly at the beginning of the handclap sound, 
you can make the markers snap to transients.

5 At the upper right of the waveform display, click the Snap pop-up menu, and choose 
Transient+Note. 
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6 Drag the start marker toward the beginning of the waveform. 

The start marker snaps precisely to the first transient on the waveform.

7 Play a C3.

The sample is triggered right away. Your sampler instrument is now ready to be played.

Adjusting the positions of sample start and end markers lets you determine exactly which 
portion of an audio file you want to trigger when playing your keyboard, and it represents 
the foundation of creating a quality sampler instrument. Using Quick Sampler’s zoom and 
snap functions, you were able to get the job done efficiently and can now focus on the 
performance.

Recording a MIDI Region to Trigger Samples

You’ll now put the recording chops you acquired in the previous lesson to good use and 
record a very simple handclap performance. You’ll play a finger snap on the second and 
fourth beat of each bar throughout the first five bars of this project to double the snare in 
the drum loop on Track 1. Let’s open the Piano Roll to see the notes you record.

1 In the control bar, click the Editors button (or press P) to open the Piano Roll.

Regions recorded on a track are assigned the track name, so it’s always a good idea to 
give your track a descriptive name before you start recording. 
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2 In the Inst 1 track header, double-click the track name, and then enter Snaps. 

When using only Apple Loops and MIDI regions, as is the case so far in this project, 
don’t hesitate to lower the tempo as needed to make it easier to perform what you’re 
recording. 

3 In the LCD display, lower the tempo down to 107 bpm. 

4 In the control bar, click the Record button (or press R).

You get a four-beat metronome count-in, the playhead reaches bar 1, and the drum 
loop starts playing back.

5 Play a C3 on beats 2 and 4 of every bar until the playhead reaches bar 5.

6 In the control bar, click the Stop button (or press the Space bar).
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Recording stops, and you have a four-bar green MIDI region on the Inst 1 track. To 
make the rhythm track, you’ll quantize your recording. If you’re unhappy with your 
performance, choose Edit > Undo Recording (or press Command-Z), and try again!

7 In the Region inspector, click the Quantize pop-up menu, and choose 1/4 Note.

In the Piano Roll, the notes snap to the nearest beat. 

8 Listen to your recording. 

The handclaps double the snare drum, bringing energy and a human character to the 
beat.

Modulating the Sample’s Pitch

To make the snaps a bit more human sounding, you’ll now modulate their pitch. In 
Quick Sampler, you’ll use a low-frequency oscillator (LFO) to generate a random signal 
and route it to the pitch parameter so that each note triggers the finger snaps sample at a 
slightly different pitch. 

Now that you have a MIDI region on the Snaps track to trigger your samples, you can 
click the play button in the Piano Roll to cycle through the MIDI region in Solo mode, 
allowing you to give your full attention to the sample’s sound while you adjust the param-
eters in Quick Sampler.
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1 In the Piano Roll, click the Play button.

Cycle mode and Solo mode are on, and the MIDI region plays back. In Quick Sam-
pler, you’ll route LFO 1 to the pitch. 

2 In the lower section of Quick Sampler, click the Mod Matrix tab. 

The Mod Matrix opens, and you can assign up to four routings. You could choose a 
controller, such as the modulation wheel as the source and the pitch as a target, to 
control the pitch with your modulation wheel. However, in order to create an auto-
matic random pitch modulation, you’ll route an LFO to the pitch, and then set the 
LFO to produce a random control signal. 

3 On the first matrix, click the Source pop-up menu and choose LFO 1. 

4 Click the Target pop-up menu and choose Pitch. 
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To clearly hear the modulation you’re routing, you can exaggerate the amount of 
modulation for now. Once you are satisfied that you’ve successfully set up your mod-
ulation routing and are getting the desired effect, you can dial the Amount slider back 
down to a more reasonable value.

5 Drag the Amount slider all the way up to 1200 cents. 

In the Pitch section, an orange ring appears around the Coarse knob that represents 
the modulation range. A white dot shows the current value for the Coarse knob, 
determined by the value sent by LFO 1. Let’s make sure LFO 1 generates a random 
signal.

6 Click the LFO 1 tab. 

7 Click the Waveform pop-up menu, and choose Random. 
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Each finger snap is triggered at a random pitch within a wide range of pitch modula-
tion. Let’s now bring that range to a more subtle value. 

8 Click the Mod Matrix tab. 

9 In the LFO 1 to Pitch assignment, drag the Amount slider down to around 135 cents. 

The pitch modulation is quite subtle now, making each finger snap slightly different 
sounding than the previous one. 

10 Close the Quick Sampler plug-in window. 

11 Stop playback. 

You’ve assigned a low-frequency oscillator with a random waveform to modulate the pitch 
of the sampler in subtle amounts. That pitch randomization is just enough to make the 
sampled finger snaps sound a bit more human.

Recording Audio in Quick Sampler

You’ll now create a new software instrument track and record your own handclap sample 
directly into Quick Sampler. You’ll then copy the MIDI region you recorded for your 
finger snaps to the new track so that you can trigger your handclap sample using the 
same note sequence. For this exercise, you’ll need to make sure the correct input device is 
selected in Logic’s audio preferences, the same way you did in Lesson 4. 

1 At the top of the track headers, click the + button (or press Option-Command-N) and 
create a new software instrument track.

2 In the instrument slot, insert Quick Sampler.

3 Above the waveform display, click the Recorder button.
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A Record button appears in the middle of the waveform display. To the lower left of 
the waveform display, make sure the input where you’ve connected your microphone 
is selected from the Input pop-up menu. To use your Mac computer’s built-in micro-
phone, use Input 1. 

 To record the output of a track in real time into Quick Sampler, choose the 
desired track from the Input pop-up menu. 

 To monitor the audio signal you’re recording, click the Monitor button below 
the waveform display. 

Below the waveform display, the Record Start pop-up menu is set to Threshold. After 
you click the record button on the waveform display, Quick Sampler waits for the 
audio signal at the selected input to reach the threshold set by the slider on the Level 
Meter slider. 

4 Clap your hands a few times and, if needed, adjust the Level Meter slider.

Watch the Level Meter. The input signal level should reach above the Level Meter 
slider position when you clap your hands. Make sure the peak value displayed to the 
right of the Level Meter does not turn red, which would indicate you’re clipping the 
signal. If needed, adjust the input gain on your audio interface. 

 When using your Mac computer’s built-in microphone, to adjust the input 
gain, choose Apple menu > System Preferences, click the Sound icon, click the Input 
button, and adjust the Input volume slider. 
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5 In the waveform display, click the Record button. 

Quick Sampler is waiting for the input level to reach the threshold set by the Level 
Meter slider to start recording.

6 Clap your hands once. 

If all went well, you can see a waveform for your handclap, and the peak detector 
to the right of the Level Meter does not go red. If your clap wasn’t loud enough, the 
recording doesn’t start, and you can clap again, louder this time. If your clap was too 
loud, the peak detector turns red; you can click the peak detector to reset it, click the 
stop button in the waveform display, and try again. 

7 In the waveform display, click the Stop button. 

The recording stops, and your sample is ready to be triggered.

8 Above the waveform display, click the One Shot button. 

Since Quick Sampler started recording exactly when you clapped your hands, the start 
marker is at the right position. 

9 Drag the end marker toward the end of your clap sample. 
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10 In the Tracks view, Option-drag the MIDI region from the Snaps track to the Claps 
track at bar 5. 

Let’s rename the new Quick Sampler track and region.

11 On the Inst 2 track (Track 3), double-click the name, and enter Claps.

12 In the Tracks view menu bar, choose Functions > Name Regions/Cells by Track Name 
(or press Option-Shift-N).

The selected region on the Claps track is renamed Claps.

13 Listen to your claps.

NOTE ▶ If you’re happy with a Quick Sampler instrument that you made in this les-
son, save it as a patch in the Library as you learned in Lesson 3. 

14 Close the Quick Sampler plug-in window. 

Don’t hesitate to use the volume sliders in the track headers to readjust the balance 
between the drum loop on Track 1 and the Snaps and Claps tracks.



250   Sampling Audio

Handclaps are easy and fun to record. If you’re not alone, try sampling a group of people 
clapping together. Don’t limit yourself to finger snaps and handclaps. When Trevor Horn 
recorded the 1980s hit song “Relax” by Frankie Goes to Hollywood, he recorded the whole 
band jumping into the pool, and you can hear the resulting samples play toward the end 
of the song. Just look around you, and experiment with whatever inspires you. Try stomp-
ing on plastic cups, punching cardboard boxes, shredding paper, and so on. All these 
sound effect samples can add great texture to your beats.

Creating a Quick Sampler Track Using Drag and Drop

For the intro, you’ll turn a vocal recording into a pad synthesizer instrument so that you 
can play melodies or chords with your keyboard. This time you’ll speed up the process of 
importing an audio file in Quick Sampler by using the shortcuts that appear when drag-
ging an audio file directly to the empty space below the track headers.

1 In the Loop Browser, search for inara.

2 Preview Inara Lyric 03.

The loop’s key is F; however, it’s currently previewed in the project key (C). It sounds 
unnaturally low. 

3 In the Loop Browser, click the action menu at the bottom left, and choose Play in 
Original Key.
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Inara’s vocals sound more natural. Let’s import that loop into Quick Sampler.

4 Drag Inara Lyric 03 to the empty area below the track headers, and in the menu that 
opens, choose Quick Sampler (original).

A new software instrument track is created with Quick Sampler in the instrument 
slot. Quick Sampler opens, and the audio file you dragged is imported in Quick Sam-
pler. Quick Sampler recognized multiple notes in the audio file and determined it was 
appropriate to use Slice mode; however, you’ll switch to a Classic mode in the next 
exercise to play a single-note sample.

Dragging audio files from the browsers, the workspace, or the Finder to the empty area 
below the track headers saves you the tedious work of creating a new track and inserting 
the Quick Sampler plug-in every time you want to experiment with sampling something.

Looping Sample Playback to Sustain Sound

When sampling material that you want to turn into a software instrument to play melo-
dies or chords, you can loop a section of the sample. A sample loop keeps repeating until 
you release the key, allowing you to sustain the sample as long as you want.
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To loop samples in Quick Sampler, you must choose Classic mode.

1 In Quick Sampler, click the Classic button. 

To the lower right of the waveform display, the root key is F2. 

2 Play an F2 note, and then play different notes on your keyboard. 

The entire vocal sample plays back, transposed according to the note you play. You’ll 
adjust the start and end markers so that a single note plays back. 

3 Drag the start marker to the beginning of the second note in the sample (around 
0.600 s). 

4 Drag the end marker to the end of the same note (around 2.300 s). 

5 Play a note.

Now only the note between the start and end markers plays. If you continue holding 
down a key, the note still stops when the Quick Sampler playhead reaches the end 
marker. Let’s create a loop section. Since you adjusted marker positions, the parameter 
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display bar below the waveform display is hiding the Loop mode pop-up menu, so 
let’s close it.

You may notice that the section of the sample you chose to trigger is actually not an F 
note. You’ll later tune your instrument to make sure it plays the correct pitches.

6 Below the waveform display, click the X to the left of the parameter display bar. 

The parameters revert to the default view, and you can see the Loop parameter.

7 Click the Loop mode pop-up menu, and choose Forward.

In the waveform display, yellow loop start and end markers let you set the loop 
boundaries. The loop section between the loop markers is yellow. 

8 At the upper left of the waveform display, click the Zoom horizontal button. 
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9 Adjust the loop start and end markers.

Continue playing an F2 note while you adjust parameters in Quick Sampler. The goal 
is to have the loop sound as seamless as possible. Unless you’re very lucky, you’re 
hearing a popping sound as the playhead skips from the loop end marker to the loop 
start marker. There are a few tools in Quick Sampler that can help that situation. 

First, you can snap your markers to zero crossings, positions where the waveform 
crosses the horizontal zero line in the middle of the waveform. 

10 Click the Snap pop-up menu, and choose Zero Crossing.

Continue adjusting the loop markers. You should hear less of a popping sound. To 
make the loop sound even smoother, you can use the Alternate loop mode, which 
plays the loop alternately from the loop start marker to the loop end marker, and 
then from the loop end marker to the loop start marker.

11 Click the X to the left of the parameter display bar to see the default parameters. Click 
the Loop mode pop-up menu, and then choose Alternate.
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Playback no longer jumps from the loop end marker to the loop start marker, making 
the loop more even. You can probably still hear clicks at the loop start and end mark-
ers, but for now, try to focus on having the pitch and amplitude of the note sound 
fairly continuous. Once you’re happy with your loop section, you can further polish 
the loop using a crossfade at the loop start and end markers.

12 Drag the crossfade marker to the left to create a crossfade at the loop start and end 
points.

Adjust the length of the crossfade so that the popping sound disappears and the loop 
sounds smooth. You may need to readjust your loop start and end marker positions. 

 In the waveform display, move your pointer in between the loop start and end 
markers, and drag left or right to move the entire loop section.

Finding the right position for a sample loop can take finessing and experimentation, 
so take your time and keep trying. 

13 Play and sustain a chord on your keyboard.

This sampler instrument still retains the original timbre of Inara’s voice, but now you 
can play it like a synthesizer on your keyboard.

Finding the best positions in an audio file for your sample start, sample end, loop start, 
and loop end markers is the foundation of good sampling. Ultimately, not all audio files 
will give you good-sounding results when looped. As you acquire more experience, you’ll 
get better at recognizing parts of recordings that will work when sampled by listening but 
also by looking at the waveform, and you’ll get faster at editing the samples.

Modulating Samples with LFOs and Envelopes

Now that you’ve turned audio material into a sampler instrument, you can use the modu-
lation section in the lower section of the Quick Sampler interface to affect different 
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playback parameters. You’ll adjust the amp envelope to give your vocal a soft, slow attack 
and a long release, turning the instrument into a synthesizer pad. You’ll then record long 
sustained chords to lay down the background harmony while adding texture. Then you’ll 
modulate the pitch of the samples to create a vibrato effect.

At the bottom of the Amp section, the envelope display lets you control how the level 
changes over time when a sample is triggered. The selected envelope type, ADSR, stands 
for Attack, Decay, Sustain, and Release—the four segments that determine the shape of 
the envelope.

1 At the bottom of the Amp section, move the pointer over the Attack handle (the first 
point in the envelope display).

The Attack field (A) is highlighted. 

2 Drag the point toward the right. 

 To adjust a handle numerically, drag its corresponding field vertically, or 
double-click the field and enter a value.
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To check your work, keep playing an F2 note after adjusting parameters in Quick 
Sampler. The Attack segment is slopped, and the samples fade in slowly rather than 
starting abruptly. Try different attack lengths, and finally settle for around 400 ms.

3 At the lower right of the envelope shape, drag the Release handle to set the release to 
around 600 ms.

The sound takes 600 ms to fade out when you release keys on your keyboard, almost 
like the sound of a reverb tail. This soft envelope is great for a pad sound. Let’s dial in 
a vibrato effect.

4 Click the Mod Matrix tab. 

5 On the first routing, click the Source pop-up menu, and choose LFO 1.

6 Click the Target pop-up menu, and choose Pitch.

7 Drag the Amount slider to around 500 cents. 

In the Pitch section, note the orange ring around the Coarse knob, representing the 
range of pitch modulation applied by your routing.
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8 Play a few notes on your keyboard.

You can hear a very wide pitch range vibrato—it sounds like a siren! A white dot 
moves around the Pitch knob to indicate the pitch in real time. Let’s dial in a more 
reasonable pitch range.

9 In Mod Matrix, drag the Amount slider to 50 cents. 

That is still a fair amount of vibrato. When you listen to and observe classical string 
players, they often attack a note with a constant pitch at first, and start applying 
vibrato with an increasing pitch range as the note is sustained. To reproduce this 
effect, you’ll apply a delay to LFO 1.

10 Click the LFO 1 tab. 

11 Drag the Fade In knob to around 2500 ms. 

Before you start recording, you need to tune the instrument. When you play an F2, 
you hear a G2 instead, so let’s fix that. 

12 At the lower left of the waveform display, set the root key to G2.

Let’s rename the track and record some chords.
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13 On the Inara Lyric 03 track header, double-click the name, and enter Synth Pads.

14 Record one-bar long notes or chords from bar 1 to bar 5 to lay down a harmony in 
the intro section.

You are just experimenting for now, so feel free to play any notes you want. However, 
if you can, keep all melodies and chords you record in this lesson in the key of C 
minor, and you’ll later be able to arrange all your tracks together into a cohesive song.

If needed, use the Quantize pop-up menu in the Region inspector to correct the tim-
ing of your performance. If some of the notes need to be edited, open the Piano Roll 
to drag the notes to the desired position or pitch. Don’t hesitate to readjust Quick 
Sampler settings to your tasting, adjusting the attack or release of the Amp envelope, 
and the amount or delay of vibrato. In the inspector, feel free to add audio effect plug-
ins to the Synth Pads channel strips. 

15 Close the Quick Sampler plug-in window. 

You have explored several methods for sampling single notes. You have imported a finger 
snap audio file, recorded your own handclaps, and sampled a vocal note to turn it into 
a new software instrument. In the process, you’ve gained familiarity with Quick Sam-
pler—using the Mod Matrix to route LFO to pitch, adjusting the Amp envelope, adjusting 
sample start and end markers, and creating a loop and making sure it cycles smoothly.

Sampling and Slicing Drums

Bringing an audio file into Quick Sampler allows for sound manipulation that opens new 
horizons. When you import a drum loop, Quick Sampler detects the transients, and Slice 
mode is automatically selected. Each drum hit is separated into a slice and mapped to a 
note pitch so that it can be triggered by a specific key.
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Slicing and Triggering Drum Samples 

You’ll use the Throwback Funk Beat 01 drum loop on Track 1 to create a new sampler 
instrument track that you can use for the song intro. You’ll shorten the individual slices 
with the Amp envelope, give the loop a lo-fi (low-fidelity) sound with a distorting filter, and 
reprogram the MIDI note sequence in the Piano Roll to switch around the pattern a bit. 

1 On Track 1, click the Throwback Funk Beat 01 drum loop to select it.

To import only one loop in Quick Sampler, you’ll temporarily turn the looping off.

2 In the Region inspector, deselect Loop (or press L).

3 Drag the Throwback Funk Beat 01 region on Track 1 to the empty area at the bottom 
of the track headers, and choose Quick Sampler (Original).
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A Quick Sampler track is created, and Quick Sampler opens in Slice mode. Slice 
markers are positioned at each detected transient on the waveform display. Below the 
waveform display, MIDI note pitches are assigned to each slice, starting on C1 and 
ascending chromatically.

 You can click the waveform display to create a slice marker, drag a slice 
marker to move it, and double-click a slice marker to delete it.

4 Rename the new track Sliced Drums.

5 On your keyboard, play some of the notes assigned to the sample slices.

For each note you play, the corresponding slice is triggered. First, you’ll re-create the 
note sequence that triggers the entire original loop on the track.

6 In Quick Sampler, position the mouse pointer to the bottom of the waveform display 
to see a drag icon.

7 Drag the MIDI region to the Sliced Drums track at bar 1.

A MIDI region is created on the track.

8 Double-click the MIDI region.

The Piano Roll opens, and you see the pattern of chromatically ascending notes that 
trigger the successive slices in Quick Sampler.
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9 At the upper left of the MIDI region in the Piano Roll, click the Play button. 

In Quick Sampler, the slices are triggered in succession, and it sounds just like the 
original loop. You are now ready to start mangling this drum loop to give it the lo-fi 
treatment that will give you an intriguing sound for the song intro. Keep the loop 
playing while you tweak its sound. First, let’s shorten the envelope of each slice to give 
the loop a muffled, cut-up sound.

10 In Quick Sampler, on the envelope display at the bottom of the Amp section, drag the 
Decay handle to set Sustain to 0% and Decay to 31 ms.

Each drum hit is cut up, as if it was harshly gated, giving a bouncy, staccato feel to the 
loop. You’ll now further distort the loop using a filter.

11 In the Filter section, click the On/Off button.



Sampling and Slicing Drums  263

12 Drag down the Cutoff knob to around 63%. 

Some of the high frequencies are filtered, and the loop sounds are muffled.

13 Drag up the Drive knob to around 50%. 

The filter is overdriven, and the loop sounds slightly distorted and punchy. To give 
the loop a crispier, edgier sound, you’ll use one of the band pass filters.

14 Click the Filter mode pop-up menu, and choose BP 6dB Gritty.

The loop sounds small and lo-fi, and the kick drum is quite distorted. Use the Fil-
ter On/Off button to compare the sound of your sampled drums with and without 
filtering.

You’ll quickly rearrange the regions in your workspace to create an intro section.

15 Press the Space bar to stop playback. 

16 Close the Quick Sampler plug-in window. 
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17 On the Slice Drums track, loop the MIDI region once so it lasts for four bars (from 
bar 1 to bar 5).

18 On the Throwback Funk Beat 01 track (Track 1), drag the Throwback Funk Beat 01 
region to bar 5.

19 In the Region inspector, select Loop (or press L).

The Throwback Funk Beat 01 region on Track 1 is looped.

20 Listen to your intro.

From bar 1 to bar 5, the sliced drum loop introduces the beat with a small, lo-fi sound 
punctuated by your finger snap samples. The small drums leave ample sonic room 
for the pad sound that you sampled from Inara’s voice. At bar 5, the full-sounding 
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drumbeat takes over. The use of a filtered drum loop in the intro makes the original 
drum loop sound bigger by contrast when it kicks in. 

Resequencing Drum Slices in the Piano Roll

On the Sliced Drums track, in Quick Sampler, each slice of the drum loop is triggered 
by different MIDI notes. That means you can now change the pitches of the notes in the 
Piano Roll to switch the beat around while keeping the same rhythm.

1 On the Sliced Drums track, click the MIDI region to select it.

The Piano Roll opens, and you see the MIDI notes that trigger the drum slices.

2 In the Piano Roll, on the keyboard on the left, click a key next to a slice number label.

The corresponding slice plays. Let’s use key commands to select different notes in 
the Piano Roll and transpose them. You’ll press the Left Arrow or Right Arrow key 
to select the previous or next note, and Option-Up Arrow or Option-Down Arrow to 
transpose the selected note up or down by one semitone.

3 Click the first note.

The corresponding slice plays.
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4 Press the Right Arrow key a few times.

With every key press, the next note to the right is selected, and the corresponding 
slice plays.

5 Use the Left Arrow and Right Arrow keys to select the second note.

6 Press Option-Up Arrow. 

The selected note is transposed up one semitone. 

7 At the upper left of the region in the Piano Roll, click the Play button.

The MIDI region plays in Cycle and Solo modes. You hear your new pattern with two 
successive snares at the beginning of the loop. The note is deselected.

8 Click any note to select it.

Continue using the same key commands to navigate from one note to the next and 
transpose some of the notes so that they trigger the desired slice.

 Press Shift-Option-Up/Down Arrow to transpose a note up or down one 
octave (12 semitones).

9 Stop playback.

10 Listen to the intro leading into the next section.
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You created a Quick Sampler track to slice the main drum loop of your song. You dis-
torted its sound, shortening the envelope and filtering the loop, and then reordered the 
individual drum loop slices in the Piano Roll to customize the loop and make it your own. 
Sampling existing material from the current song to transform it and make it sound dif-
ferent is an efficient way to come up with new, interesting parts for different song sections.

Transposing a Sample While Keeping It Synced to the 
Project Tempo

Sometimes you hear a recording and fall in love with the sound of an instrument. Unfor-
tunately, the instrument is playing a melody that doesn’t work for your song, or you have 
a better idea for what you would have done, if only you could have access to the original 
instrument. That’s exactly what sampling can help you achieve.

In this exercise, you’ll sample an arpeggiated bass synth and turn it into a Quick Sampler 
instrument, making sure the arpeggiated notes play at the song’s tempo no matter what 
pitch they’re transposed to. 

1 In the Loop Browser, search for Alpha Matrix Bass.

2 Drag Alpha Matrix Bass to the empty area at the bottom of the track headers, and 
choose Quick Sampler (Original).
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A new Alpha Matrix Bass track is created, and Quick Sampler opens with the Alpha 
Matrix Bass loop loaded.

3 At the upper left of the waveform display, click the Classic button.

4 Play different keys on your keyboard.

The root key of the sample is C2. If you play a C2, you hear the original pitch and 
speed. If you play a note above C2, the sample is pitched up and sped up. If you play 
a note below C2, the sample is pitched down and slowed down. Let’s make sure the 
playback speed doesn’t change when playing different notes.

5 Below the waveform display, click the Flex button.

6 Play the project from the beginning, and exactly on the first downbeat of bar 5, play 
and hold down a C2 note, and then try playing other notes on downbeats.

All notes play at the same tempo. Because the Follow Tempo button next to the Flex 
button is on, the arpeggiated notes play at the project tempo and are in sync with the 
Throwback Funk Beat 01 drum loop. 

Let’s create a short loop section so that each key triggers only a small section of the 
original Alpha Matrix Bass loop.

7 Stop playback.
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8 Below the waveform display, click the Loop mode pop-up menu, and choose Forward.

The yellow loop markers are displayed, and the waveform is yellow.

9 Above the waveform display, click the Snap pop-up menu, and choose Beat. 

With the loop markers snapping to the nearest beat, it’s now easy to create a loop that 
has an exact number of beats.

10 Drag the loop end marker to Beat 3.

The loop keeps repeating the same four notes on the same pitch. With this type of 
sound, and because you’re synced to the project tempo and snapping to the beat, 
there’s no need to add a crossfade. It’s not easy to play melodies. A fun effect you can 
play with is the pitch glide from one note to another.

11 In the Pitch section, drag the Glide knob up to around 170 ms. 

When you play a note, the pitch slides from the pitch of the previous note to the pitch 
of the new note, creating a nice portamento effect. You may notice a clicking sound 
on the attack of the notes you play. Let’s remove it.
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12 In the Amp section, on the envelope display, drag the Attack handle to about 6 ms.

13 Record a simple bass line over four bars, starting at bar 5 after the intro.

Don’t stray too far away from the original C2 pitch, or you may get too many artifacts 
in the sound of the samples and the glide effect may ruin the sync of the loop. Quan-
tize your recording in the Region inspector, and edit the notes in the Piano Roll until 
you’re happy with your bass line.

14 To complete this new song section, loop the Claps and Alpha Matrix Bass tracks until 
bar 13.

You’ve sampled and looped only a short slice of a bass Apple Loop to turn it into a soft-
ware instrument that you can play on your MIDI keyboard, allowing you to use that bass 
sound to play your own melody. Imagine the vast array of opportunities now that you can 
sample from any Apple Loops or other recordings, and then turn them into instruments 
to use in your own productions.

Chopping Loops in a Take Folder

While a sampler can often greatly speed up your workflow, you can do sampling work 
without one. To cut up your samples, mangle them by processing them through effects, 
and splice them, you are free to use any other tool at your disposal. One of the most obvi-
ous and immediate techniques is to drag your samples directly to the Tracks view, and 
then edit the regions to cut and process your samples.

Packing Regions into a Take Folder

In the previous lesson, you recorded several takes of a guitar performance packed into a 
take folder. That lets you experiment with different ideas during the recording session, 
and then later assemble a composite take by choosing sections from multiple takes—a 
process called comping.

Comping techniques can be useful, for example, when a musician can’t get an entire song 
right in one single take. You record several takes, each with its own good and bad quali-
ties, and later you create a perfect comp using the best parts of each take. 

In this exercise, you’ll use a take folder for a more creative music production goal. You’ll 
pack four loops of various instruments playing different melodies, and then create a comp 
by selecting slices from the different loops to combine them into a patchwork loop—like a 
rhythmic collage of bits and pieces that each have a different timbre. 
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1 In the Loop Browser, search for the following loops and drag them to create new 
tracks at the bottom of the workspace at bar 13.

Throwback Funk Brass 01

Throwback Funk Synth Bass

Throwdown Synth Lead

Tiny Toy Synth

To help identify the loops, let’s give them different colors and simple names.

2 Click the Throwback Funk Brass 01 region to select it.

3 Press Shift-N and enter Brass.
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4 Choose View > Show Colors (or press Option-C).

The Color palette opens.

5 Click a yellow color square.

The Brass region is yellow.

 The Color palette displays a white frame around the color(s) of the selected 
region(s). This is useful when you need to assign other regions the same color.

Repeat this process to rename and color the remaining three loops in the take folder.

6 Rename Throwback Funk Synth Bass Bass, and color it brown.

7 Rename Throwdown Synth Lead Ambient, and color it turquoise.

8 Rename Tiny Toy Synth Synth, and color it pink.

9 Choose View > Hide Colors (or press Option-C) to close the Color palette.
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10 Select the four regions at bar 13.

11 In the Tracks view menu bar, choose Functions > Folder > Pack Take Folder. 

The four loops are packed inside a take folder on the selected track, leaving you with 
three empty tracks that you can delete.

12 Choose Track > Delete Unused Tracks (or press Shift-Command-Delete).

The empty tracks are deleted. Let’s rename the track where the take folder is.

13 On the Throwback Funk Brass 01 track header, double-click the track name and enter 
Splice. 

The take folder is selected, and you can name it after the track name.

14 Choose Functions > Name Regions/Cells by Track Name (or press Option-Shift-N).

15 Control-click the icon on the Splice track, and choose the desired icon.

16 Resize the take folder to shorten it to two bars long.
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17 Double-click the take folder to open it.

18 Choose Navigate > Set Rounded Locators by Selection and Enable Cycle (or press U).

To zoom in on the selection, you can press Z (Toggle Zoom to Fit Selection or All 
Contents).

19 Press Z.

The take folder fills the workspace, making it comfortable for you to see the wave-
forms on each take.

You’ve imported four Apple Loops into your workspace and packed them into a take 
folder. A little organization goes a long way, and taking the time to give your region 
simple descriptive names and easy-to-identify colors, and optimizing your zoom level sets 
you up nicely for the next exercise, where you’ll assemble your composite take.

Comping Takes

Before you start comping, you need to preview the takes so that you can become familiar 
with them. Then you’ll start comping the takes, swiping your mouse across the parts of 
the takes you want to hear in your comp. To create a rhythmic effect synced to the project 
tempo, you’ll snap your edits to the nearest 1/16 note. 
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1 In the Tracks view menu bar, click the Snap pop-up menu, and choose Snap Quick 
Swipe Comping.

2 Click the Snap pop-up menu again, and choose Division.

By default, the division is a 1/16 note, so swiping takes will snap to the nearest 1/16 
note on the grid.

3 Option-click the Brass take to select it.

4 On the Bass take, drag to select from 13 1 3 0 to 13 2 0 0 so that the help tag reads 
Position 1 1 3 1, Length 0 0 2 0. 
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The pointer snaps to a 1/16 note grid, making it easy for you to select a section that 
has musical meaning (for example, a 1/16 note, an 1/8 note, or a beat).

 To temporarily disable snapping, start dragging and hold down Control, or 
Control-Shift for even greater precision.

5 Listen to your comp.

The comp starts with a brass note, and then the following syncopated note is from the 
distorted bass synth loop.

6 On the Ambient take, select the note right after the bass slice so that the help tag 
reads Position 1 2 1 1, Length 0 1 1 0.

The comp now plays successive notes from the brass, then the distorted bass synth, 
then the ambient synth. The rapid rhythmic timbre switching creates an exhilarating 
sensation that is sure to make people get up and dance! 

When you select a section, you can hear that section in different takes.

7 Try clicking different takes in the same section as that last note.
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A different take is selected only for that section. This gives you an easy way to experi-
ment with selecting the same section in different takes.

8 Within that section, click the Ambient take again.

9 Continue making selections of single or multiple notes (or even portions of notes) 
from different takes throughout the rest of the take folder.
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Feel free to have fun and experiment to find what sounds good to you; then, for 
the next exercise try to reproduce the comp on the previous screenshot as close as 
possible.

You’ve comped the four loops into an exciting 1/16 note–based rhythmic collage. Keep 
this technique in mind and be creative with your use of material. For example, think of 
comping vocal regions to create a vocal chop, or drum regions to create a breakbeat.

Processing a Selection with Audio Effect Plug-ins

When you are happy with your comp, you can flatten it to export all the selections as indi-
vidual audio regions on the track so that you can further edit or process them. You’ll now 
flatten the take folder you comped in the previous exercise so that you can use the Region 
inspector to transpose individual notes and apply selection-based processing to process 
individual sections with audio effect plug-ins.

1 At the upper left of the take folder, click the Take Folder pop-up menu, and choose 
Flatten.

Take Folder pop-up menu

Each section of the comp is now an individual region of the color of the original take. 
All regions have the same name (Splice: Comp A). Let’s give the regions individual 
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names. When multiple regions are selected, giving one of them a name that ends with 
a number results in the regions getting the same name but with incremental numbers.

2 Press Shift-N.

A text field opens on top of the first region.

3 Enter Slice 1.

The regions are named Slice with incremental numbers. Let’s transpose the Slice 3 
region (the turquoise region that contains a note from the Ambient loop).

4 Click the background in the workspace to deselect all regions (or press Shift-D).

5 Click the Slice 3 region to select it.

6 In the Region inspector, click the double-arrow symbol next to Transpose, and choose –12.

Use the Space bar to start and stop playback when you need to hear your work. The 
Slice 3 region now plays one octave lower. Continue transposing some of the regions 
to +12 or –12 semitones so that they play an octave higher or lower. Feel free to 
experiment with other values; however, in that case, make sure the transposition 
amounts you choose maintain all the notes in the right key or the loop may sound out 
of key with the other sections in the project.
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You’ll now apply an effect plug-in to only one region using selection-based process-
ing. To make it easier for you to hear the result of your processing, you may want 
to start with one of your longer regions. If you reproduced the same comp as in the 
screenshot in the previous exercise, you’ll apply the effect to the Slice 7 region.

7 Select the Slice 7 region (or one of your longer regions) on the Splice track. 

 To apply selection-based processing to only a portion of a region, select the 
portion with the Marquee tool (your default Command-click tool).

8 In the Tracks view menu bar, choose Functions > Selection-Based Processing (or 
press Shift-Option-P).

The Selection-Based Processing window lets you choose between two sets of plug-ins 
(A or B) so that you can experiment with and compare two audio processing signal 
chains. You’ll use only one plug-in, so let’s insert it in set A.

9 Click an empty slot in set A, and choose EQ > Channel EQ. 

The Channel EQ plug-in window opens.
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10 In the Channel EQ plug-in header, click the Setting pop-up menu, and choose 07 EQ 
Tools > Phone Filter Notch.

This severe EQ preset filters most of the low and high frequencies, letting through 
only a narrow band of midrange frequency, reminiscent of the low-fidelity sound of 
older phones. Before you preview the result, you’ll make sure the preview function 
does not affect your current cycle area so that you can preview the effect of the EQ 
plug-in in the context of the entire loop.

11 At the lower left of the Selection-Based Processing window, click the action menu and 
deselect “Preview enables Cycle.”

12 Click the Preview button. 
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Playback starts at the beginning of the cycle area at bar 13, and you can hear the 
EQ’ed Slice 7 region in the context of the entire section. The EQ cuts off so many fre-
quencies that the processed region sounds too soft now.

13 Click the Preview button to stop playback. 

14 In the Selection-Based Processing window, click the Gain pop-up menu, and choose 
Loudness Compensation.

The loudness compensation will be processed only after you apply the effect.

15 At the lower right of the Selection-Based Processing window, click Apply. 

In the workspace, the selected region is processed by the Phone Filter Notch Channel 
EQ preset. The new region is automatically assigned the color of the track (blue).

16 Press the Space bar. 

The processed region now sounds loud enough. All the different timbres in the sam-
ples combined together create a fun, syncopated new loop!

 To change the level of one or more regions, select the region(s) and use the 
Gain parameter in the Region inspector. 

17 Close the Selection-Based Processing and Channel EQ plug-in windows.

18 Click the cycle area (or press C) to turn off Cycle mode.
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You flattened your take folder to export the selected portions of your takes into individual 
regions in the workspace. You then transposed some of the regions in the Region inspec-
tor and processed one region with a plug-in, completing your patchwork sample collage.

Creating Vocal Chops

Vocal chops, a vocal editing technique pervasive in today’s pop songs, are cut-up vocal 
samples sequenced together in a new way. The cuts are often small, unrecognizable 
pieces of words, sometimes just individual vowels, and the goal is to create a fun, creative 
sound effect that may sound like the singer’s voice but that doesn’t have any comprehen-
sible lyrics. Tiny samples are sometimes repeated in rapid fashion to create stuttering 
effects, and the use of pads to trigger the samples in a rhythmic fashion often results in 
syncopated grooves.

Slicing a Vocal Recording in Quick Sampler

To get started building your vocal chops, you’ll turn a vocal recording into a Quick Sam-
pler instrument.

1 Go to Logic Book Projects > Media, drag Just Like This Vocal.wav to the empty area 
at the bottom of the track headers, and choose Quick Sampler (Original).

A new software instrument track is created, and Quick Sampler opens with the Just 
Like This Vocal.wav sample loaded.
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2 At the top in Quick Sampler, click the Slice mode button.

Slice markers appear on the waveform display where transients were detected. Too 
many transients were detected, so you need to reduce the number of slices.

3 Below the waveform display, drag the Sensitivity slider to 40.

That’s much better, but there are still a few misplaced slice markers that you’ll later 
edit on the waveform display. Look at the long sample slice assigned to D#1.

4 Play a D#1 on your keyboard.

You hear the word “this.” The entire sample plays, as in One Shot mode. To bet-
ter control the length of the vocal notes you perform, you’ll use Gate mode. In Gate 
mode, the sample plays only for as long as you hold down the key (or for the duration 
of the MIDI note on the track).

5 Below the waveform display, click the Gate button.

6 Play a short D#1 note on your keyboard.

Now only the beginning of the slice plays, and playback stops when you release the 
key. For greater control, let’s make the envelope release more abruptly.
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7 In the Amp section, on the envelope display, drag the Release handle all the way to 
the left so that the Release field reads 0 ms.

8 Play short D#1 notes in rapid succession.

Now you can play some percussive stuttering riffs with this sample.

You’ve imported your vocal sample in Quick Sampler, chosen the Slice mode, adjusted the 
sensitivity slider to get the right amount of slices, and turned on Gate mode to make sure 
the samples you trigger stop playing back when you release the key.

Editing Slice Markers

Adjusting the Sensitivity slider in the previous exercise gave you approximately the slices 
you wanted on this vocal sample; however, you’ll fine-tune the slice markers to make sure 
you’re in complete control over what portion of the file gets triggered by your keys.

To zoom in on the waveform display, you can use Control-Option-drag (and Control-
Option-click to zoom out), or a pinch gesture if you’re using a trackpad.

1 Control-Option-drag to zoom in on the first four slices. 

2 Play a C1.

The first slice plays. You hear the word “just”; however, the word is cut off at the end.
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3 Play a C#1.

The second slice plays. You hear the “s” sound at the end of the word “just.” The first 
and second slices are the same word and should be only one slice. Let’s delete the sec-
ond slice marker.

4 Double-click the second slice marker to delete it. 

5 Play a C1.

The first slice plays, and you hear the entire word.

6 Play a C#1 (and hold it down for the full duration of the slice).

You hear the word “like” and, at the end of the slice, the beginning of the next word, “this.”

7 Play a D1.

You hear the word “this”; however, the very beginning is cut off. Let’s readjust this 
slice marker.

8 Drag the D1 slice marker slightly to the left.
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Continue playing C#1 and D1 notes and adjusting the slice marker until you no lon-
ger hear anything at the end of the C#1 slice and you clearly hear the beginning of the 
word “this” at the beginning of the D1 slice.

Let’s continue cleaning up slice markers.

9 Play F#1, G1, and G#1.

The three notes are each one a piece of the word “moment.” Let’s make sure a single 
key triggers the entire word.

10 Scroll right to see F#1, and delete the two slice markers directly to the right of the F#1 
note.

The note F#1 should trigger the entire word “moment.”

11 Delete the two slice markers directly to the right of the G1 note.

The note G1 should trigger the entire word “just.” The slice markers are now all posi-
tioned at the beginning of a word, so let’s practice playing this new chopped vocal.

12 Play short notes, trying some rapid short notes between C1 and A1.
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For some fun, chopped vocal-stuttering effects, you can trigger slices in the middle 
of word so that you can play only the vowel part, without the consonants at the 
beginning.

13 Click the Zoom horizontal button.

14 Create a flex marker after D1, in the middle of the word “this.”

15 Play the D#1 key, and alternate it with D1.

You can already hear the kind of stuttering sequences that you’ll be able to program 
in the next exercise. If you play fast, syncopated beats by hitting keys or drum pads 
on your controller, you may notice that some of the samples don’t trigger fast enough. 
For such percussive performances, results are sometimes better when moving the slice 
markers a little bit farther into the word, cutting off some of the slow attack to trigger 
right into the vowel of each word. Try zooming in and moving your slice markers a 
little farther past the attack of each word, as in this screenshot. Experiment and see 
what works best for you.

Triggering and Recording a Vocal Chop

With all your slice markers at the right positions, you can practice a groove on your con-
troller and then record it. This kind of sampling work lends itself well to playing synco-
pated rhythms. Let’s give it a try.
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1 Position the playhead after the chopped samples on the Splice track (at bar 15).

2 Press Record.

You get a four-beat count-in. Get ready! Play your favorite vocal chop groove within 
the C1 to A1 key range. If you don’t get it right the first time, don’t hesitate to con-
tinue recording, and you can later cut the MIDI region to keep only the good part 
of the performance. Or stop the recording, choose Edit > Undo Recording (or press 
Command-Z), and try again.

3 Stop the recording.

Don’t forget that you can quantize the MIDI region in the Region inspector, or dou-
ble-click the region and edit notes in the Piano Roll.

To give your vocal chops a sound that resembles the pitch variations heard when DJs 
scratch vinyl records, you can add pitch glide to Quick Sampler.

4 In Quick Sampler, in the Pitch section, drag the Glide knob up to around 103 ms.

Now each slice attack has a 103 ms pitch ramp up or down from the previous pitch. 

If you’re so inspired, take a moment to continue adjusting the sound of all your 
tracks, add effect plug-ins, and move or copy your regions in the workspace to create 
different sections. When you’re done, you can save your work and open an example 
project that uses the techniques you’ve learned in this lesson.
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5 Choose File > Save (or press Command-S).

6 Choose File > Close Project (or press Option-Command-W).

7 Open Logic Book Projects > 05 Sample Feast.

8 Play the project.

Listen to the different sections, and use Solo mode to focus on each track individually. 
Explore this project: open the Quick Sampler plug-ins, zoom in on the audio regions, 
look at their Transpose values in the Region inspector, and open the MIDI regions in 
the Piano Roll to look at the MIDI notes.

Note that the Just Like This Vocal track has some automation that makes the envelope 
release increase while the reverb goes crescendo in bars 19 and 20. You’ll learn how to 
add automation to your tracks in Lesson 10.

You’ve used samples both in a sampler plug-in and directly in the workspace. The Quick 
Sampler plug-in is now familiar to you, and you know how to import audio, switch 
modes, edit markers, and add modulation to your samples. You’re now well on your way 
to becoming a sampling ninja!
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Key Commands

Keyboard Shortcuts

Piano Roll

Left Arrow Selects the previous note

Right Arrow Selects the next note

Option-Down Arrow Transposes the selection down one semitone

Option-Up Arrow Transposes the selection up one semitone

Shift-Option-Down Arrow Transposes the selection down one octave

Shift-Option-Up Arrow Transposes the selection up one octave

Tracks View

Command-Option-N Opens the New Tracks dialog

Option-Shift-N Names selected regions by track name 

Shift-Command-Delete Deletes unused tracks 

Shift-N Renames a region

Shift-Option-P Opens the Selection-Based Processing window

General

Control-drag Disables snapping temporarily

Shift-Control-drag Disables snapping temporarily, allowing 

for greater precision

Shift-Command-N Creates a new project

Shift-D Deselects all
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attention capture, 47
audio effects

monitored during 
recording, 182–183

plug-ins. see plug-ins
settings, 137–140

Audio Engineering Society, 174
Audio FX area

analog tape preset, 474
inserting plug-in into, 

135, 137
plug-in format options, 

163
processing signal in, 129
Remix FX in, 325
Tremolo plug-in, 507

audio interface setup,  
176–178, 179

Audio preferences, 176, 177, 
179, 182

audio recording. see recording
auditioning loops, 39
Auto Gain, 458, 459, 475
automatic punching, 195, 

200–203
automation

drawing offline, 465–470
mixer parameter, 464–473
mixing console, 465
panning in surround 

field, 495

pitch bend, 358–362
points, 467
recording live, 470–473
Remix FX, 346
step pattern, 346–348
surround sound, 507–512

Automation Curve tool, 361
Autopunch mode, 200–203
autosaves, 9
Aux channel strip, 150, 153, 

449, 504, 505

B
backup vocals

balancing volume of, 438, 
439, 441

equalization of, 444, 
446, 447

muting for, 450
panning of, 442
reverb for, 447, 450, 

463, 464
submix for, 428, 438
Track Stack for, 431

balance
bed tracks in surround 

field, 496
checking the, 186–187
volume, 355, 438–441

bars, 42
bass line

editing, 61–66
pitch bend automation, 

358–362
programming MIDI, 

348–351
beats

defined, 42
hip hop, 113–117
metronome-free 

recording, 229–232
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recording with 
continuous, 223

sampling for texture in, 
250

Step Sequencer for, 
332–335

syncing loops to, 269
syncopated, 288

bed tracks, 495, 496–498
Binaural Render, 490, 491, 502
bit depth, 172, 173
Bluetooth pairing, 309
Bounce dialog, 76
bouncing songs, 75–77, 479
breakbeats, 278
breaks, taking, 481
buffer sizes, 182
building songs, 34–54
bus sends

adding effects via, 146
Aux channel strip, 

150–153
defined, 149
reverb via, 449, 463, 504

C
Cell inspector, 224, 226
cells

control pads for, 294
editing pattern, 381–382
Logic Remote to  

start/stop, 323
organization of, 18
queueing, 19
reassigning key 

command, 319
recording audio into, 

226–229
recording into Live 

Loops, 220–229
recording parameters for, 

224–226
Channel EQ plug-in

EQ curve on, 107, 445–447
Tone knob for, 123
vocal track shaping with, 

450–456

channel strips
bus sends to, 149–153
clearing, 155
key commands, 526–528
locked screenset of, 

435–437
Mixer options, 72
naming, 68–72
order of plug-ins in, 

161, 164
removing plug-ins 

from, 141
routing data to, 343
Stereo Out, 473
track automation for, 465

chords
iPad playing of, 313
wrong, 65

Chorus marker, 97
Coaching Tips, 320
collections of loops, 26
color

Flex Pitch, 419, 423
note velocity and, 354
track, 180–181, 272

columns, 18
commercial mix 

comparisons, 482
compact disc sample rate, 174
Compare button, 163
comping, 270
Complete Mode, 5
Complexity Range sliders, 

119, 120
composite takes

automatic creation of, 199
benefits of, 270
defined, 190
exporting selections, 

278–283
recording, 190–195
samples, 274–278

composition, 348
compressor

compressing vocals, 
456–461

function of, 478
mastering with a, 475–476

Compressor plug-in, 458, 464
consoles, mixing, 465
content creation

adding fades, 367–370
DMD patches for, 377
editing audio regions, 

362–367
key commands for, 

374–375
Piano Roll programming, 

348–362
Step Sequencer, 332–348
writing in MIDI 

regions, 331
control bar

defined, 30
shortcut, 201
Smart Controls for, 293

Controller Assignments 
window, 295–296, 297

controllers
automated mixing 

consoles, 465
identifying tracks 

with, 316
iPads as, 309, 324
MIDI. see MIDI 

controllers
pads for Live Loops, 

294–297
using external, 293

Control-Option-drag, 52, 53
converter, A/D, 172, 184
copying regions, 47–49
copying scenes, 384–387
copyright issues, 236
count-ins, 194, 222
crescendos, 101, 102
curve, frequency, 451
curve, pitch, 421, 423
curves, automation, 466, 468
curves, tempo, 398–402
customization

drum kit, 105–113
drum machine sound, 

120–126
locked screenset, 435–437
plug-in, 137–138, 168
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Cutoff knob, 263, 300, 301, 
302, 314

cutting, with Marquee tool, 
61–66

cycle areas
creating, 37, 438
setting locators for, 38

Cycle button, 38
Cycle mode

Dolby Atmos mixing 
and, 494

MIDI recordings and, 
219, 220

Pattern Browser, 336
recording takes in, 193–195
soloing regions in, 87

Cymbals slider, 94

D
dampening, 111
Decay field, 256, 262, 380
default configuration, 30
delay, 447–450
deletion

arrangement marker, 99
loop, 23–24
Marquee tool for, 54
patch, 168
recording, 189
region, 63, 365
track, 9–10
unused audio recordings, 

204–207
depth, adding, 461–464
dequeueing

cells, 21
loops, 20

digital audio recording, 
171–178

digital converters, 172
disclosure triangle, 110, 160
distortion

adding, 138
Bitcrusher, 304
Dolby Atmos mixing and, 

491, 495
Downsampler slider, 

327–328

drum slice, 263
mastering for, 477
plug-in order and, 164
reducing, 146

dithering, 480
DJ effects

Remix FX, 324
Varispeed, 406

Dock, adding Logic Pro to, 7
Dolby Atmos

audio effect plug-ins, 
503–512

CPU usage for, 514–515
key commands, 515
loudness levels in, 491–495
master file export, 

512–515
mixing in, 485–495
panning in surround 

field, 495–503
downloads, 9, 309
Downsampler slider, 327–328
Drive knob, 263, 304, 305, 

307, 308
Drum Kit Designer, 82, 

107–113
drum kits

customizing, 105–113
drummer changes with, 

85, 89
Drum Machine Designer

customization with, 
120–126

electronic samples, 82
importing audio into, 

377–381
drum machines, 113–126
Drummer

arranging track, 95–105
creating a new track, 

82–95
different instruments 

in, 108
drum kit customization, 

105–113
style choice, 85–89
visual drum hits in, 84

drummer
choosing, 85–89
editing intro, 100–102
editing outro, 103–105
editing performance of, 

89–95
electronic, 113–126

Drummer Editor
drum machine 

samples, 114
drummer choice in, 86, 87
electro-house beat, 

117–120
drums

3D sound space for, 
503–504

adjusting levels for, 
105–107

arranging track, 95–105
creating gap in, 54–56
crescendoing, 101, 102
electro-house, 117–120
genres of, 85
hip hop beat, 113–117
importance of, 81
iPad playing of, 314
programming patterns, 

335–343
resonance on, 111
sampling/slicing, 259–267
Step Sequencer, 332–335

dry audio, 149
dub music, 162
duplicating scenes, 22–24

E
ear fatigue, 481
echoes, 161–162, 163
Edit Mode, 341–342
editing

audio regions, 362–367
bass line, 61–66
drummer, 82, 83, 89–95
fades to soften, 367
intro, 47–49
loops, 34
MIDI events, 213
mouse tools for, 54–56
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nondestructive, 205
patches, 145–149, 166
plug-in parameters, 163
region timing, 409–418
samples, 239–241
scenes, 22–24
slice markers, 285–288
vocal chops, 283
zooming for easy, 103

electro-house music, 117–120
envelopes

abrupt-releasing, 284–285
DMD, 380
modulating samples with, 

255–259
shortening, 262
types of, 256

equalization (EQ)
plug-ins for, 444–447
seek-and-destroy 

approach, 452
vocal track shaping with, 

450–456
Expert view, 295
exporting mixes, 478–481, 

512–515
External Assignment Learn 

button, 300

F
Fade tool, 367–369
faders

adjusting multiple, 315
mapping volume, 305–309
mixing console, 465
recording movements 

of, 302
volume, 440

fades, adding, 367–370
fast-forwarding, 36
feedback

avoiding during 
recording, 177, 
180, 182

extending, 162
Feedback slider, 318
files, project

access to, 137

exporting mix to, 478–481
format choices, 479
mixing down to, 75–77

fills, 101
Fills knob, 92, 101
filters

adjusting, 301
low-pass and  

high-pass, 325
finger snaps, sampling, 

236–246
Flanger, 163
Flex & Follow Tempo, 399, 400
Flex Pitch, 418, 419, 424
Flex Time, 409, 412–414, 424
folders, project

chopping loops in, 
270–283

multiple takes, 190–
191, 218

package saves, 176
saving to, 137

Formant hotspot, 423
Forward button, 36
four-on-the-floor beat, 

117–119
frequency spectrum, 444–447, 

450–456

G
gain

Adaptive Limiter and, 477
adjusting the, 73
equalization and, 452
microphone preamp, 184
vocal compression and, 

458–459
Gain knob

Amp Designer, 148–149
microphone preamp, 

184–185
Gain Reduction, 457, 458, 474
Gate mode, 284, 285
Gate slider, 327
gating, rhythmic, 362, 364
glide, pitch, 269–270, 288
Global Tracks, 95–96
Grid Stop, 21, 24, 223, 386

groove, matching a, 403–405
guitar

distortion on, 132, 
138–139

editing outro, 133
Guitar Scratch FX, 465, 469
Gyroscope button, 328, 329

H
HALF TIME channel strip, 

504, 506, 507
hand claps, sampling, 236–246
Hansa Tonstudio, 504
harmonic movement, 57
headphones, 182, 442, 485, 489
Help

documentation, 31
Logic Remote, 309, 

318–321
help tags, 42, 44, 356
high velocity, 354
hi-hat, 100, 342
Hi-Hat slider, 91
hip hop, 113–117, 235
Hip Hop Drummer, 114
horizontal zooms, 50, 51
Horn, Trevor, 250
Humanize knob, 115

I
iCloud syncs, 8
imports, audio

Apple Loops, 393–395
Drum Machine Designer, 

377–381
key/tempo matching for, 

390–392, 395–398
Quick Sampler, 236–239

input clipping
mastering for, 473–475
recording and, 184–185, 247

Input Device, 176, 179
inspector, 30, 40
instruments. see also software 

instruments
bus sends of, 150–153
creating patterns for, 335
equalizing, 444
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mixing, 68, 437
naming, 70
playing individual, 

130–133
software plug-ins, 140–142
tuning, 185–186
turning vocals into, 

283–285
volume adjustments, 

72–75
interface overview, 28–34
intro

arrangement marker, 96
drum slices in, 260–265
editing the, 47–49, 

100–102
multiple plug-ins on, 161
role of, 47

iPads, 309, 324
iPhones, 310

J
judgment, refreshing your, 481

K
Keep Project Tempo, 392
key commands

assigning, 196, 197, 
297–299

content creation, 374–375
corresponding menu 

items, 38
Dolby Atmos, 515
Drummer, 127
focused pane, 13
general, 78, 329
how to use, 34–36
list of, 78–79
Logic Remote, 318–321
mixing, 483
overview of, 523–529
Play From Selection, 133
punching on the fly, 

196–197
recording, 233
sampling, 291
screensets via, 432
Step Sequencer, 332

transposing notes with, 265
zooming, 50–53

keyboards, as MIDI 
controllers, 210

keys
changing imported audio, 

396–398
changing song, 46–47
original loop, 395
transposing, 57, 60–61

kick drum, 91, 111, 117–119
knobs

mapped to parameters, 
302–305

recording movements 
of, 302

L
Latch mode, 472
latency reduction, 182, 

485–486
lead vocals, 450–464
Learn button

External Assignment 
area, 300

Parameter Mapping area, 
303, 305

Remix FX, 346
Learn New Assignment 

button, 297–299
length, note, 353–355, 356, 357
length of region, 42
Level Meter, 247
Library

browsing presets in, 
141–142

key commands, 169, 528
patch display, 135
Producer Kits, 109
using patches from, 

145–147
limiters, 476–477
Linn, Roger, 235
Live Loops

adding loops to scenes, 
15–18

assigning pads to, 294–297

browsing/previewing 
in, 9–15

grid organization, 18
key commands, 233, 528
Logic Remote for 

triggering, 321–324
new project in, 7
populating scenes in, 

381–384
recording into, 220–229, 

385–387
Scene trigger, 21
Tracks view and, 32

Live mode, 214
locators, setting, 38, 41
lo-fi drum sample, 262, 264
Logic Pro

plug-in format choice, 134
and recording quality, 172

Logic Remote app
automation recording 

and, 471
connecting/installing, 

309–311
controlling Logic via, 

309–324
Drum Kit Designer, 108
Drum Machine 

Designer, 122
Help in, 31, 318
key commands, 318–321
mixing with, 315–318
playing software 

instruments, 312–315
project navigation, 

311–312
triggering cells/scenes 

with, 19
triggering Live Loops, 

312–324
Loop Browser

adding region to, 372
available loops listed in, 7
similar loop searches in, 23

Loop tool, 59
loops

adding to scenes, 15–18
auditioning, 39
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browsing/previewing, 
9–15

creating new section 
with, 57

default key of, 43
key of, 395
lengthening, 67
Logic Remote for 

adding, 321
moving, 42
playing, 18–22
programming drum, 

339–343
queueing, 19
repetitive previews of, 37
sample, 251–255
syncing to the beat, 269
timeline for editing, 34

loudness levels, Dolby Atmos, 
491–495

low velocity, 354
low-frequency oscillator 

(LFO), 243, 246, 255–259
LUFS (Loudness Unit relative to 

Full Scale), 491, 494, 512

M
Mac computers

audio interface, 172
Logic Remote to 

control, 310
macOS key commands, 

79, 529
Remix FX on, 325

maps, tempo, 229, 402
markers, arrangement, 95–100
Marquee tool

automatic punching 
with, 203

creating silences with, 
54–56

cutting with, 61–66
repeating sections with, 366

mastering
Dolby Atmos export, 

512–515
file format for, 479
tips for quick, 473–478

melody, introducing the, 47
merging patches, 153–157
merging recordings, 217–220
Metronome

recording without, 
229–232

settings, 188
syncing MIDI with, 215
tempo matching with, 392

Microphaser plug-in, 135, 136
microphone preamps, 172, 184
microphones, 172, 179
MIDI

cells, 382–384
correcting timing in, 

214–217
defined, 208
drum slices in, 261–263
events, 208, 210, 211
external devices, 210
mapping DMD patches 

to, 377
Piano Roll programming 

of, 348–363
plug-ins, 129, 143–145
quantizing, 224–226
recording, 209–214, 

220–223
recording samples with, 

241–243
MIDI controllers

assigning pads on, 
294–299

features of, 293
key commands, 329
Logic Remote as, 312
playing virtual 

instruments with, 
208–209

Smart Controls, 299–302
triggering files with, 19, 

236–239
MIDI FX area, 143
MIDI Out, 335, 351
MIDI regions

converting pattern region 
to, 349–351

Drummer, 108, 116

instrument plug-ins 
for, 140

project tempo for, 398
recording over, 217–220
single track for, 157
writing content in, 331

mistakes, fixing recording, 
195–204

Mix section, 106
Mixer

customizing, 435
naming tracks in, 69–71
plug-in insertion in, 166
resizing the, 72
surround format, 488
toggling with Tracks area, 

432–435
tools in, 32

mixing
automating mixer 

parameters, 464–473
bass and drums, 355
Dolby Atmos, 485–495
down to stereo files, 

75–77
equalization (EQ), 

444–447
exporting mix, 478–481
goals of, 427
headphones as aid to, 442
hearing minor 

adjustments, 74
importance of names 

in, 72
key commands, 483
Logic Remote, 315–318
panning, 441–444
processing lead vocals, 

450–464
quick mastering, 473–478
screensets for, 432–435
songs, 68–75
submixes with Track 

Stacks, 428–432
tips and tricks, 481–482
volume balance, 438–441

mobile Logic app, 309–324
Mod Matrix, 244, 257
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modulation, 255–259, 503–504
monitoring of recordings, 

176–178, 247
Monophonic mode, 412
mouse, external

control devices, 294–297
tools on, 54–56

MP3 file format, 76
multiple plug-ins, processing, 

161–166
multitrack recorders, 464
musicians, on-the-fly 

punching for, 196, 200

N
naming

recording after, 180
tracks and channel strips, 

68–72
navigation

assigning buttons for, 299
key commands, 78, 

524–525
Logic Remote projects, 

311–312
playback with key 

commands, 34–36
practicing, 47

New Tracks dialog, 28–29
No Overlap, 65, 67
nondestructive editing

punching, 195
quantizing as, 215, 216
recordings and, 205

Normalize, 479
notes

changing length/velocity 
of, 353–355

clock ticks and, 42
creating Piano Roll, 

355–358
iPad playing of, 313
lengthening, 145
MIDI, 211, 348
Step Sequencer, 334
time-stretching single, 

415–418
transposing, 351–353

O
Object Panner, 499–500
object tracks, 498–503
Octafuzz pedal, 138–139
offline automation, 465–470
on-the-fly punching, 195, 

198–200
One Shot mode, 238–239, 379
Option key, 48
organization, workspace, 

428–437
Output Device, 176, 179
outro

arranging, 99
customized plug-in for, 138
editing drum, 103–105
editing guitar, 133
punctuating, 66

outside listens, 482

P
package saves, 176
pads, control via, 294–297
Pan knob, 73, 441, 470–472
panes

key commands, 78, 523
shifting focus on, 13

panning
stereo field, 441–444
surround field, 495–503

parallel processing, 149–161
Parameter Mapping area, 303, 

304, 306
patches

Drum Machine Designer, 
377, 381

layering, 157–161
Library display of, 135
loading and editing, 

145–149
merging, 153–157
preset patterns for, 

335–336
saving user, 166–169, 249

Pattern Browser, 335–339
pattern region

added to audio track, 
343–346

automation of, 346–348
converted to MIDI 

region, 349–351
loading/saving, 335–339
previewing, 334
programming, 335
Step Sequencer editing, 

381–382
peak level, 75, 248
Pedalboard plug-in, 138
Pencil tool, 355, 356
performance

additional takes, 190, 270
correcting errors in, 

195, 200
correcting timing of, 214
Drummer, 82, 83, 85, 89, 

100, 103
limitations of real-time, 331
panning to emphasize 

individual, 444
programming MIDI, 129, 

143, 186, 235
real-time 

experimentation 
with, 387

recording over a, 217, 220
samples, 241, 243
tempo of, 231

phaser effect, 135, 136
Phrase Variation knob, 115
piano, 344
Piano Roll

correcting notes in, 213
creating notes in, 355–358
drum slices in, 260, 

261–262
editor, 116–117
key commands, 291, 

375, 529
MIDI recordings, 212, 218
pitch adjustment in, 

243–244, 259
programming MIDI in, 

348–363
Quantize parameter, 

215, 217
transposing notes in, 265
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pitch
Apple Loops, 174
arpeggio effect, 144
changing imported 

audio, 396
changing playback, 

406–409
correcting, 389
glide, 269–270, 288
modulation, 257–258
note, 356, 357
pitch bend automation, 

358–362
programming MIDI 

for, 350
randomizing sample, 

243–246
risers, 25
sample playback, 238
transposing, 267, 351–353
tuning vocal recordings, 

418–424
Pitch Bend, 359, 465
Play From Selection, 133
playback

browsing loop, 13
key commands for, 

34–36, 524–525
loop and scene, 18–22
Pattern Browser, 336
pitch/speed changes, 

406–409
Play From Last 

Position, 312
punching in and out 

with, 195
reducing interruptions 

in, 41
sample, 238, 253–255
Solo mode, 130–131
speed and pitch, 268

playhead
Cycle mode recordings, 194
Logic Remote, 311
positioning, 36
punching on the fly 

position, 199
zoom sliders and, 50, 51

plug-ins
audio effect settings, 

137–140
Bitcrusher, 302–305
changing order of, 164
Channel EQ, 445–447
copying/moving, 161–166
Drum Kit Designer, 

107–113
editing parameters for, 163
exporting selections, 

278–283
formats for, 134
inserting, 129–145
latency-inducing, 182
loading/editing patches, 

145–149
mapping Smart Controls 

to, 302–309
MIDI, 143–145
presets, 133–137
Quick Sampler, 235
Remix FX, 324–329
removing, 141
saving settings, 166–169
software instrument, 

140–142
step automation for, 332, 

346–348
surround, 503–512
undoing changes to, 451

Polyphonic mode, 412
portamento effect, 269
position of region, 42
prerecorded music

Apple Loops as, 9
inspiration via, 171
matching project tempo 

to, 390–392
sample rate of, 174
tempo matching with, 389

Presence knob, 149
presets, plug-in, 133–137
processed audio, 149
Producer Kits, 108
professional mix 

comparisons, 482
programming MIDI, 348–362

Project Audio Browser, 528
Project Chooser, 6–7
Project Settings, 487
Project Tempo, 229
projects

building/navigating, 
34–54

creating new, 3–9
Dolby Atmos mixing 

of, 486
folders for, 137
key commands, 233
Logic Remote, 311–312
matching tempo of, 372
mixing down, 75–77
new audio tracks in, 

28–29
recording, 173–176
setting tempo of, 389
settings for, 175

pulse-code modulation (PCM) 
files, 478

punching in and out, 195–204

Q
quantizing

MIDI regions, 214–217
Quantize parameter, 

223, 224
samples, 243

queueing loops, 19, 294
Quick Help, 30, 31
Quick Sampler

audio imports, 236–239
audio recording in, 

246–250
drag-and-drop track 

creation, 250–251
drum slices, 259, 261
editing in, 239–241
filter adjustments, 301
LFO, 243
One Shot mode, 379
pitch glide, 288
vocal slicing in, 283–285

R
randomizing pitch, 243–246
Record Toggle, 196, 198
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recording
additional audio takes, 

190–195
adjusting source levels, 

184–185
audio, 187–190, 226–229
audio interface setup, 

176–178
balance for, 186–187
deleting unused files, 

204–207
Dolby Atmos mixing 

and, 486
key commands, 233
live automation, 470–473
Live Loops cell, 220–229
matching project tempo 

to, 389–395
MIDI, 209–214, 383
MIDI region replacement, 

217–220
monitoring during, 

182–183
multi-source, 180
preparing a track for, 

178–182
punching in and out, 

195–204
setting sample rate/bit 

depth, 171–176
slower speeds for, 408
Tracks view, 384–387
tuning instrument for, 

185–186
tuning vocal, 418–424
vocal chops, 288–290

region, 83
Region inspector

MIDI Defaults, 216
parameter checking in, 

40, 58
processing selections 

in, 278
Quantize menu, 214, 215, 

217, 259
Transpose parameter, 

65, 396

regions
adding fades to, 367–370
anchoring, 50
colors for, 272
converted into Apple 

Loops, 371
copying, 47–49
cutting, 61–66
dividing, 101
editing, 54–68, 362–367
editing timing of, 409–418
joining and repeating, 

365–367
key commands, 526–528
MIDI, 108, 116, 220
nondestructive editing 

in, 205
position and length of, 42
previewing, 206
processing comp, 278–279
quantizing MIDI, 214–217
recording over MIDI, 

217–220
refreshing, 92
sampling with MIDI, 

241–243
screensets and, 434
selecting/deselecting, 

37, 130
slicing, 362–365
soloing, 87
swapping positions of, 

63–64
tips for dragging, 159

“Relax” (Frankie Goes to 
Hollywood), 250

Release field, 256, 257, 285
Remix FX, 324–329, 344, 

346–348
repeats, continuous, 36–41
Resize pointer, 103
reverb

3D sound space for, 
504–507

adding, 447–450, 461–464
bus sends for, 150–152
customized drum 

machine, 125

Rewind button, 36
risers, 25
Roland TR-808, 332

S
sample rate

bouncing files and, 480
defined, 172
Dolby Atmos mixing and, 

486, 487
recommended, 174
setting a, 173–176

sampling
audio imports, 236–239
chopping loops in, 

270–283
composite takes, 274–278
copyright issues, 236
drums, 259–267
editing waveform 

markers, 239–241
key/tempo matching, 

395–398
looping sample, 251–255
machine, 235
MIDI recordings, 241–243
modulating with LFOs 

and envelopes, 
255–259

pitch modulation, 243–246
processing comps, 

278–283
single notes, 236–259
transposed sample, 

267–270
vocal chops, 283–290

Save dialog, 8
saves

autosaves, 9
folders for, 137
frequent, 18
location for, 167
new projects, 7–8
package, 176
plug-in settings, 166–169

scaling volume control, 
305–309

Scene trigger, 20, 297
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scenes
adding loops to, 15–18
copying/recording, 

384–387
creating new, 25–28
duplicating/editing, 

22–24
Logic Remote for 

triggering, 322
organization of, 18
playing, 18–22
populating Live Loops, 

381–384
queueing, 19
reordering, 26
trigger timing for, 28

screensets
customizing locked, 

435–437
locked, 434–435
Mixer/Tracks toggling 

with, 432–435
secondary kick, 117–118
selection-based processing, 

278–283
Sensitivity slider, 284
Set to Perfect Pitch, 420, 421
shakers, 119, 121–123
Shuffle mode, 63, 64
signal routing, 159, 160
silence, 93
skills review, 517–522
Slice mode, 259, 261
slicing

drums, 259–267, 412
markers for, 285–288
regions, 362–365
vocals, 283–288

sliders
entering values for, 156
Remix FX, 327
zoom, 49

Smart Controls
assigning knobs to, 

299–302
Drive knob, 307
Drum Machine Designer, 

121–123

Drummer, 105–106
editing patches with, 145, 

147–149
Logic Remote, 312–313
mapped to plug-ins, 

302–309
transporting functions 

to, 293
Smart Help, 309, 321
Smart Tempo

automatic matching 
with, 396

metronome-free 
recording, 229–232

Smart Tempo Editor, 391, 392
snapping, 274–276
snares

auditioning, 124–125
customizing drum kit, 110
kick and snare beat, 

117–119
samples, 108

software instruments
Dolby Atmos mixing 

and, 486
Live Loops template, 221
Live mode, 214
MIDI controllers for, 208
new track for, 246
played with Logic 

Remote, 312–315
plug-ins, 140–142
saving patches, 169
summing stacks of, 158
triggering, 140, 141

Software Monitoring, 177
Solo button, 134
Solo mode

benefits of, 134
playing instruments in, 

130–133
sample modulation 

with, 243
soloeing regions

benefits of, 87, 403
snare, 124
timing edits via, 410
volume balance via, 440

song sections
alternating between, 24
building new, 25–28, 

41–47
continuous repeats of, 

36–41
creating new, 57–61
Live Loops 

experimentation 
with, 387

selecting, 24
Tracks view, 30
transitions into, 49

songs
arrangement markers, 

95–100
ending, 66–68
faithfulness to genre, 427
mixing, 68–75

sonic texture, 75
Space Designer, 506
speakers

headphones vs., 442
listening with a variety 

of, 482
surround sound, 485, 491

Speed Only mode, 406, 408
spherical panning, 508
splicing loops, 235
step pattern, 346–348, 512
Step Sequencer

adding pattern regions, 
343–346

creating step automation, 
346–348

drumbeat programming, 
339–343

editing pattern cells, 
381–382

grid organization, 332–335
key commands, 375, 528
loading/saving patterns, 

335–339
turning steps on/off, 

332–335
stereo field

dimensionality in, 75, 166
panning in, 139, 441–444
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stereo file, mixing down to, 
75–77

Stereo Out, 473
stereo position, adjusting, 72–75
storage space, 204
style, drummer, 85–89
submixes, 428–432, 444
Summing Stack, 431, 432
summing track stacks, 157–161
Surround Panner, 496–498, 509
surround sound, 485, 488
Sustain field, 256, 262
sustained sound, 251–255
swapping regions, 64
swing groove, 403
Swing knob, 92, 115
synced playback

composite takes, 274
help tag and, 42, 44
Live Loops for, 220
loop and scene, 18–22
quantizing MIDI 

regions, 215
queue light indication, 19
sample transposing and, 

267–270
syncopated rhythms, 288, 

339, 354

T
takes, additional recording

chopping loops among, 
270–283

comping your, 274–278
digital audio, 190–195
flattening folder of, 278
MIDI, 217–220

Tape Delay plug-in, 164, 166, 
317, 448

tempo
Apple Loops, 174
changes and curves, 

398–402
changing drum, 89
changing playback, 

406–409
default, 14, 35
half-time, 114

maps, 402
matching prerecords to, 

389, 395–398
matching project, 372
metronome-free 

recording, 229–232
sets, 399
song endings, 66
transposing samples in, 

267–270
ways to change, 19

Tempo track header, 399
timbre, changing, 107, 423, 444
time, saving, 34
time-stretching notes, 415–418
timing

correcting MIDI, 214–217
editing region, 409–418

tips, coaching, 320
toms

choosing, 100
primal sound, 103
tuning, 112

Tone knob, 106, 123, 149
tool menus, 54
Touch mode, 472
Track Activation button, 386
Track Stacks

drum kit, 110
submixes via, 428–432
summing, 157–161, 

431, 432
Varispeed and, 406

tracks
arranging drum, 95–105
bed and object, 496–503
creating drum, 82–95
drag and drop to create, 

250–251
electro-house, 117–120
identifying, 316
key commands, 233, 

526–528
matching grooves in, 

403–405
multiple plug-in, 161–166
naming, 68–72
new, 44

organizing, 428–437
prepped for recording, 

178–182
recording onto audio, 195
soloing, 410
take folder, 273
track automation, 465–470
Track Stacks, 110

Tracks view
benefits of, 28, 34
copying/recording scenes 

in, 384–387
defined, 30
key commands, 169, 

291, 375
new song in, 34–54
programming bass line 

in, 350
toggled with Mixer, 

432–435
transients, 240, 284, 477
transitions, 59
transport buttons, 34–36, 

297–299
Transpose parameter, 57, 65, 396
transposing

composite takes, 279
mood change via, 60–61
notes, 351–353
tuning vocal recordings, 

418–424
wrong chords, 65

Treble knob, 149
Tremolo plug-in, 503, 507
triggering

cells and scenes, 19
drum samples, 260–265
MIDI controllers, 236
multiple loops, 294
pads for, 297
samples, 238, 241–243
Scene trigger, 20
scenes, 383
software instruments, 

140, 141
timing for, 28
vocal chops, 288–290

Tuner button, 185
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U
undoing actions, 14, 48
user forums, 3
user patches, saving, 166–169

V
Varispeed, 406–409
velocity, changing

bass line note, 353–355
drum, 340

Verse marker, 97
vertical zooms, 51–52
vibrato, 256, 258
virtual room, 461
Vocal Verb Aux, 461
vocals

adding delay/reverb to, 
447–450

balancing volume of, 
438–441

compressing, 456–461
panning, 441–444
processing lead, 450–464
time-stretching, 415–418
tuning recordings, 

418–424
vocal chops, 235, 278, 

283–290

volume
adjusting instrument, 

72–75, 147
automation curve, 

468–469
balancing levels, 438–441
default, 14
Dolby Atmos mixing and, 

491–495, 498
fixing vocal 

inconsistencies, 
456–461

input, 247
mapping controls to, 304, 

305–309
object track, 498

W
waveforms

editing markers in, 
239–241

time-stretching, 409–414
zooming in on, 52

Wi-Fi network, 309
windows

key commands for, 523
organizing, 428–437

workflow
DMD audio imports, 

377–381
increasing efficiency of, 34
key commands, 387
latency reducing, 485–486
Live Loops population, 

381–384
Tracks view scene 

recording, 384–387
workspace

defined, 35
editing regions in, 54–68
hiding unnecessary 

items, 42
organizing your, 274, 

428–437
overview of, 28–34
selecting regions in, 37
zooming in/out of, 49–54

workstation prep, 4

X
XY pads, 324, 325–327, 346

Z
zero crossings, 254
zooming in/out

key commands, 78, 
525–526

workspace, 49–54
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